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1 Foreword 

This standard describes the requirements and procedures for the Three Dimensional Technical Data 

Package (3D/TDP) solid model repository established and maintained by PdM-MTV.  The 3D/TDP is 

based on Creo Parametric Mechanical Design Automation software for the purpose of Computer Aided 

Design (CAD).  The 3D/TDP uses Windchill PDMLink Product Data Management (PDM) software 

for data management and storage. Creo Parametric and Windchill PDMLink are both products of PTC. 

All contractors and government personnel working with models contained within the 3D/TDP system 

shall follow the requirements of this standard regarding both Creo Parametric and Windchill 

PDMLink.  Documents that are not solid model related but which normally comprise a TDP such as 

packaging sheets, quality assurance provisions, electrical schematics, etc. shall be stored in Windchill 

PDMLink. 

1.1 0BBackground 
In order to take advantage of available technologies, PdM-MTV has been maintaining the 

technical data system including 3D solid models.  The intent is to develop, maintain, and provide these 

3D/TDPs throughout the lifecycle of the item.  3D/TDPs will be used for development, production, life 

cycle management, configuration management, logistics support, and all other purposes that would 

normally use technical data.  The 3D based system will have the following advantages: 

 Automated generation and update of line drawings

 Automated Bills Of Material (BOM)

 Infinite viewpoints and exploded views of assemblies

 Rapid prototyping

 Faster design updates

 Improved logistics support

 Improved system interface analysis

 Better and faster engineering analysis capabilities (kinematic, dynamic, and structural analysis,
tooling design, etc.)

 Reduced TDP interpretation errors

In order to use solid models as a basis for the technical data it is important that the solid models

be built to a set of common standards, using sound modeling practices, and be fully defined. 

Performing cosmetic modeling (in which a model looks like it is supposed to but is actually 
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dimensionally incorrect), may be faster and easier; however, as a basis for product definition is 

inadequate. 

Appendix D.5 Checklists referenced within this standard, defines required criteria for promotion 

approval to the Released state.  Any requirements made by this standard must be met, whether or not 

they are cited on the checklist. 

The FMTV PDMLink User Guide document, referenced within this standard, defines procedures to be 

followed when using Windchill PDMLink in conjuncture with the 3D/TDP effort.  DRAFT
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2 Configuration Management Representations 

2.1 1BStandards Application 
The requirements of this specification apply to all objects, parts, assemblies, and/or drawings that are 

submitted through the formal release process via Windchill Change Notice from In Work to Released.  

2.2 2BDrawings Required 
All parts and assemblies promoted to Released shall have associated, fully defined 2D drawings or a 

PDF copy of the latest (requires prior TACOM approval for PDF). Only the models/drawings 

representing the latest design configuration (i.e., the latest revision drawing plus any outstanding 

ECPs) shall be promoted through the release process.  This does not apply to Standard Parts, which are 

defined in Appendix F. 

2.3 Engineering Changes 
Models/drawings shall be changed via approved Engineering Change Proposals (ECPs) only.  ECPs 

shall conform to MIL-STD-3046. 

2.4 3BConfiguration Management 
When 3D/TDP associated 2D drawing are released in the database, that drawing becomes the master 

for configuration management purposes (i.e. drawings will not be input into the 3D/TDP and 

concurrently maintained in another CAD format.)  Refer to MIL-STD-3046 for complete 

Configuration Management standards. 

2.5 4BProducts 
The Product in Windchill PDMLink for the FMTV 3D solid modeling TDP will provide enough detail 

for files to be checked into the database in the appropriate location.  
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2.6 5BObject Status 
The user making changes on a drawing, part, assembly, or other object for release in the FMTV 

database shall set the Commonspace status to Checked Out while change is in progress.  The status 

should be applied when the drawings are identified for the ECP. 

2.7 6BSecurity 
This system security falls under the Windchill system security settings. 

2.8 7BRevision Scheme 
The initial release of drawings, parts and assemblies will be the  -  revision level.  Subsequent changes 

will be from a one to three digit alphabetic character (not including letters  I ,  O ,  Q ,  S ,  X , or  Z .  

(i.e., A, B, C,… AA, AB, AC, … YYV, YYW, YYY.) Refer to ASME Y14.35M for further 

information about Revision Scheme. 

2.8.1 The part or assembly revision scheme is dependent to its associated drawing and vice 

versa. The Creo Parametric drawing, and model revision shall be the same for FMTV 

drawings/models.  All changes to model and drawing will follow formal ECP procedures. 

2.8.2 The revision of the drawing shall be displayed on all drawing sheets in accordance with 

the current acceptable drawing format.  As new revisions of the models and drawings are 

created the next higher revision will be used for the current drawing. 

2.9 8BPromotion 
Drawings submitted for promotion shall follow instructions found in FMTV PDMLink User Guide. 

2.10 9BQuality Assurance 
All parts, assemblies, and drawings submitted for promotion shall be checked in accordance with 

Appendix D.5 Checklists. 
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2.10.1 All Creo Parametric objects promoted to Released are required to pass the FMTV 

ModelCHECK process.  

2.11 10BRelease Level Flowchart 
The following flowchart illustrates the FMTV release scheme using the ECP2 or ERR process in 

Windchill PDMLink. 

FIGURE 1:  ECP2 RELEASE LEVEL FLOWCHART 

2.12 Notice of Revision 
The Notice of Revision (NOR) document shall be a redline markup of the previous revision of the 

drawing.  If the drawing is an Initial Release drawing, the NOR is not required.  The redline NOR is 

submitted and stored with the ECP document. 
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3 Part Modeling Standards  

3.1 11BPart Modeling Practice 

3.1.1 Parts should be functional and created in a logical sequence.  Features should be simple 

and be created such that they are easily modifiable by another user.  Parts shall have every 

feature that the real part is required to have.  For example, plastic parts should contain every 

draft angle and radii detail expected on the real part. If text (e.g. part number) is stamped or 

molded into a part, that should also be modeled.  Parts should be able to stand on their own 

without reference to other parts or assemblies. 

3.1.1.1 If the part is a source controlled drawing or vendor item control drawing, CAD 

Files from the vendor will be requested.  If the CAD file is unavailable, all interface and 

envelope dimensions shown on the drawing shall be modeled.  The part shall be 

modeled in Creo Parametric. 

3.1.2.1 For Creo Parametric conversion efforts, features will be created using the 

existing dimensioning scheme contained in the drawings or other appropriate source. 

All changes to the drawing shall be documented by the NOR/ECP.  

3.1.2.2 For new parts and design changes, features will be created in a logical manner 

in which the dimensioning scheme for the new part will be shown with no created 

dimensions on the drawing (unless required). 

3.1.3 All models shall regenerate successfully with all features in the unsuppressed state. 

When parts are modified, the next higher assembly shall also be capable of being successfully 

regenerated. 

3.1.4 The latest FMTV_START_PART or FMTV_START_ SHTML _PART shall be used for 

part creation. 
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3.1.5 Sheetmetal parts shall be created with the Creo Parametric  Sheetmetal module. 

3.1.6 All routed tubing or piping models and assemblies shall be created using the Creo Piping 

and Cabling Extension. 

3.1.7 All wiring and cabling models and assemblies shall be created using a combination of 

Creo Piping and Cabling Extension.   

3.2 12BTolerances 
All dimensions shall include tolerances as required to be shown appropriately on the drawing.  When 

geometric tolerances, geometric tolerance datums, inspection dimensions, datum targets, and/or basic 

dimensions are required, these shall be set in the model using the appropriate GTOL commands. 

3.3 13BMaterials 
Materials shall be identified on the part in two locations: 

1. The materials section under Model Properties in Creo Parametric.  Material file creation shall

be requested from the custodian of the material file library for any material required that is not

in the current library.

2. In the materials note section of the 3D notes which are applied to the drawing.

3. The material file used on the part shall match the material called out in the notes (for example:

ASTM A36 material file shall be used over a generic STEEL material file)

3.4 14BSurface Finishes 
Surface finishes shall be shown on the part as required. 

3.5 15BModel Notes 
Sufficient model notes shall be used to describe the part and part features.    If notes are intended to 

apply to specific features, they shall be attached to those features.  Notes found in the FMTV start parts 

include: 
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a. Distribution_Note:  The drawing distribution statement shall be included in a 3D note called

Distribution_Note.

b. Proprietary_Note:  If a proprietary legend is required on the drawing, this legend shall be

entered on the model as a 3D note entitled Proprietary_Note.

c. Export Control Note: The drawing export control warning note shall be included in a 3D note

called Export_Control_Note

d. Note1:  Note1 shall contain the current drawing standards.

e. Note2 – Note#:  These notes shall be used to describe the model as required for the drawing.

f. DRW_NOTE: This note is a summary of all the Note1-Note# for display on 2D Parametric

drawing.

g. Note0_DESIGN_INTENT:  Note0_DESIGN_INTENT shall be used to document design

intent.  Design intent is any optional information the designer thinks is valuable to those who

might view the model at some future point.  An example of a design intent note is as follows:

THIS PART IS MADE OF ALUMINUM 7075-T6. CARBON STEEL WAS TESTED BUT 

CORRODED DURING USE. USE OF STAINLESS WAS CONSIDERED BUT NOT PURSUED 

DUE TO TIME CONSTRAINTS. 

3.6 16BRelations 
Relations shall have no errors upon regeneration.  Relations found in feature CS0 and ACS0 of the 

FMTV start models are required.  

3.7 17BDefault Datums 
All parts will start with default datum planes and a default coordinate system identical to those found 

in the FMTV start models.  The default datum planes shall be named FRONT, TOP, and SIDE.  The 

coordinate system shall be named CS0 with its orientation as follows; Z axis is elevation, X axis is 

along the length of the vehicle, Y axis across the vehicle width. 

3.8 18BPart File Names 
Parts shall be named using the following convention: 
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          CAGE_PartNumber.prt   i.e.   19207_8448510.prt 

If the model requires an extension (or suffix) it will follow the convention described in Table 1 – 

Model Name Suffix Usage. 

Suffix Range Description 

-001 -399 Fully detailed down level parts on a drawing. 

-100 -150 

Down-Level detailed parts that are part of weldment that are the same 
base number of the weldment assembly. (Note: This is an overlap for 
the -001 thru -399, but the down-level weldment parts are to start at -
100.  Fully detailed parts are still allowed to use -100 thru -150). 

-400 -499 Parts modified in the field for the application of a kit. 

-500 -599 Non-detailed down level parts on a drawing. 

-5000 - Top Level 87T – Used for Large Assemblies 

-600 -699 Routed systems models (cabling, piping, etc…) 

-6000 -6999 
Overflow for routed systems models (cabling, piping, etc…) if more 
than the original -600 through -699 are required 

-700 -799 Simulation models (as well as the extension _FEA) 

-800 -899 Backdrop Parts / Assemblies 

-900 -998 
Overflow or for miscellaneous (deformed, die, shrinkwrap parts, etc.)  
Deformed parts may also use the _def naming convention. Same intent 
for dies and shrinkwraps. 

-9000 -9999 
Overflow or miscellaneous parts if more than the original -900 through -
998 are required. 

-999 or -gen Non-useful generic components used in Family Tables. 

_skel Skeleton Models 

-opt, -oc Optional Configuration (either is acceptable) 

-cast Use for castings when a casting is an Alternate Design 

TABLE 1:  MODEL NAME SUFFIX USAGE
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127B3.8.1 Hardware File Names 

Hardware naming convention shall generally start with -001 and is not required to follow 

Section 3.8.  

128B3.8.2 Exceptions 

- Refer to Section 7 - Electrical for naming convention on Schematics and Electrical related 

components. 

- Refer to Section 8 - Piping for naming convention for Piping Assemblies. 

3.9 19BModel Views 
All models shall have separately named views defining the TOP_VIEW, BOTTOM_VIEW, 

LEFT_VIEW, RIGHT_VIEW, BACK_VIEW, FRONT_VIEW, and DEFAULT views. These views 

exist in the FMTV start part.  The FRONT view is oriented facing the yellow (or primary) side of the 

FRONT datum plane, with the yellow side of the TOP datum plane facing up. The remaining 

orthogonal views follow standard third angle projection practice.  Current drawing models should be 

created such that the named views correspond to the existing drawing views. 

3.10 20BDeformed Parts 
Deformed parts will have to be handled on a case to case basis.  If a part can be deformed in 

numerous shapes (rivets), then use the non-deformed part.  This makes it easier, rather than having 

100+ deformed parts.  In addition, Flexible Components shall ALWAYS be considered first and is 

preferred over a deformed part.  This will help keep the data management aspect to a minimum. 

3.10.1   Naming Convention for Deformed Parts 

Only use the non-deformed part’s part number with the extension starting with a -9xx.  Also, -

9xxx can be used if there are numerous instances of the deformed parts.  Do not use the top assembly 

name with -900 as was previously used. 

3.10.2   When to use Deformed Parts 

1. Create a deformed part if it will only be needed on a particular drawing.  (Examples are
lanyards, cables, etc).

2. Create a deformed part if the non-deformed part causes a major interference.

3. Create a deformed part if the non-deformed part will not work in any way possible.
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3.10.3   Creating Deformed Parts from Tabulated Parts 

If a deformed part is made from a tabulated part, keep the tabulation and add the -900 extension 

after.  (Ex: 19207_12345678-001 will be 19207_12345678-001-900 when it is deformed). 

3.10.4   Creating Deformed Parts with Flexible Components 

The preferred option when creating deformed parts is using flexible component functionality. 

Flexible components allow the model to be represented in different states within different assemblies. 

Flexible components shall always be looked at first for any deformed part/assembly.  An example of 

this is if a drawing of a spring requires it to be modeled in its free state but when it needs to be 

assembled it must be represented in its compressed state.  With flexible component functionality it 

would not require that a second model to be created.  It allows the designer to vary dimensions, 

parameters, resume or suppress features (or components if flexible component is a sub-assembly).   

3.10.5   Promoting Deformed Parts 

When promoting a deformed part, promote it with the assembly where the deformed part is 

used.    Keep the deformed part at the same revision level of the most current non-deformed part in 

Windchill PDMLink database.   Also, remember to relate all deformed parts back to the non-deformed 

parts drawing while the drawing is being updated.  If the deformed part is just being used on a next 

higher assembly, it shall be related back to the deformed parts drawing the next time the drawing is 

revised.  When a previously released deformed part is required to be changed in an ECP due to other 

changes that affect said part and the base part is not part of that ECP, either a new flexible model state 

or a standalone model shall be created with another -9xx extension. The new model shall have the 

same revision as the base number. 

3.11 21BLayers 
The following layers shall be used in part mode (these exist in the FMTV start part).  Other layers may 

be added as needed, for example, a datum required on a drawing may be placed on a separate layer so 

that it can stay on while the other datums are layered off.   
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Layer name Layer Assignments 
Default 
State 

a. DTM_AXES All datum axes Hide 

b. DTM_CSYS All datum coordinate systems Hide 

c. DTM_CURVES All curve features Hide 

d. DTM_PLANES All datum plane features Hide 

e. DTM_POINTS All datum point features Hide 

f. G_DTM_PLANES All geometric tolerance datum planes Hide 

g. ITEM_ID Only the cosmetic/curve feature describing the part identification number Hide 

h. NOTES All part notes Hide 

i. SURFACES All surface features and quilts Hide 

j. THREADS All cosmetic and actual threads Hide 

k. XSEC_DATUMS All cross-section datums  Hide 

TABLE 2: PART LAYERS

3.12 22BPart Parameters 
The following parameters are required when entering a part or assembly into the 3D/TDP Product 

Release Process. Required items are noted in the Input column.  

Items in italics are no longer required to be filled out, but will remain for legacy drawings. Windchill 

PDMLink will manage these parameters. 

Parameter Name Parameter Description Format Example Input 

01* AGENCY Agency or service US ARMY * 

02 CAGE_CODE Original design activity CAGE code 19207 REQ 

03 CATALOG_NOMENCLATURE Nomenclature assigned by supply SPRING, HELICAL 

04 CHECKER_NAME Person that checked the original drawing K.BALL REQ 

05 CONTRACT_NUMBER  Contract #-original design contract DAAE20-03-C-S023 REQ 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV  

Page 13 13 February 2014 FMTV-MODELING-STD-100T  Rev.L 

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

06* DESIGN_ACTIVITY Design activity  
Tank Automotive & 
Armaments Command 

REQ* 

07* DESIGN_ACTIVITY_LOCATION 
Design activity city, state and zip code Warren, MI 48397-

5000 
REQ* 

08 DESIGN_APPROVAL_NAME Person who approved design A.TAYLOR REQ 

09 DESIGN_CONTRACTOR Original design contractor 

STEWART & 
STEVENSON 
SERVICES, SEALY 
TEXAS U.S.A. 

- 

10 DISTRIBUTION_CODE Distribution Statement (A, B, C, D, E, X) A REQ 

11 DRAWING_APPROVAL_NAME Person who approved drawing A.TAYLOR REQ 

12 DRAWING_DATE Date original drawing created YY-MM-DD REQ 

13 DRAWING_NUMBER 
Drawing number the part/assembly is 
defined on 

12414568 REQ

14 DRAWING_REV Revision of current drawing B Legacy 

15 DRAWN_BY Person who created original drawing J.WENNER REQ 

16 ENGINEER_NAME_1 Primary design engineer A.WURFEL REQ 

17 ENGINEER_NAME_2 Secondary design engineer J.ZEBROWSKI - 

18 ERR_ECP_APPROVAL Approving official of latest ECP N.TAUBE - 

19 ERR_ECP_DATE Date current revision was released YY-MM-DD REQ 

20 ERR_ECP_NUMBER ECP that caused current revision TACV1234 REQ 

21 ITAR 
Controlled by International Traffic in Arms 
Regulation 

YES REQ

22 JEWEL_BEARING 
YES-NO PARAMETER, contains jewel 
bearing 

NO -

23 MATERIAL_ENGINEER Person who approved material for design M.CHURCH REQ 

24 MATL_CLASS Automatically filled out - 

25 MATL_GRADE Automatically filled out - 

26 MATL_HEAT_TREAT Automatically filled out - 

27 MATL_NAME Automatically filled out - 

28 MATL_SHAPE Automatically filled out - 

29 MATL_SPECNO Automatically filled out - 
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30 MATL_TYPE Automatically filled out - 

31 MATL_UNS_NO Automatically filled out - 

32 MODEL_REV Revision of current model B Legacy 

33 MODELER_NAME_1 Primary Pro/E modeler J.WENNER REQ 

34 NEXT_ASSY_1 
First next higher assy part no. (shall match 
USED_ON_1 below) 

12419847-001 REQ

35 NEXT_ASSY_2 Second next higher assy part no. - 

36 NEXT_ASSY_3 Third next higher assy part no. - 

37 NEXT_ASSY_4 Fourth next higher assy part no. - 

38 NEXT_ASSY_5 Fifth next higher assy part no. - 

39 NEXT_ASSY_6 Sixth next higher assy part no. - 

40 NEXT_ASSY_7 Seventh next higher assy part no. - 

41 NEXT_ASSY_8 Eighth next higher assy part no. - 

42* NOMENCLATURE Drawing name. (See paragraph 3.12.3) 
BODY ASSEMBLY, 
CARGO, MTV LWB 

REQ* 

43 NOMENCLATURE_1 First line of drawing nomenclature BODY ASSEMBLY, - 

44 NOMENCLATURE_2 Second line of drawing nomenclature CARGO, MTV LWB - 

45 NOMENCLATURE_3 Third line of drawing nomenclature - 

46 OZONE_DEPLETING_CHEMICAL  
YES-NO PARAMETER, ozone depleting 
chemical  

NO -

47 PART_NUMBER Item part number 12423205 REQ 

48 PMIC Precious Metal Indicator Code A - 

49 QA_ENGINEER_NAME Quality assurance engineer P.FIESTER REQ 

50 REMARKS See paragraph 3.12.2 PRELIMINARY  Legacy 

51 SOURCE_CONTROL YES-NO PARAMETER, source control NO - 

52 SPEC_CONTROL YES-NO parameter, spec control  NO - 

53 SPEC_NUMBER 
Specification Number, Used on SPEC 
Parts only 

ASME B18.2.1 - 

54 SPECIALTY_METAL  YES-NO PARAMETER, specialty metal NO - 
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55 TOLERANCE_1_PLACE Default tolerance if indicated on drawing .1 - 

56 TOLERANCE_2_PLACE Default tolerance if indicated on drawing .03 - 

57 TOLERANCE_3_PLACE Default tolerance if indicated on drawing .020 - 

58 TOLERANCE_ANG 
Default angular tolerance if indicated on 
drawing 

.5 -

59* UNIT_WEIGHT Mass value. (See paragraph 3.12.4) 1.25 REQ* 

60 USED_ON_1 First used on item FMTV A1P2 REQ 

61 USED_ON_2 Second used on item - 

62 USED_ON_3 Third used on item - 

63 USED_ON_4 Fourth used on item - 

64 USED_ON_5 Fifth used on item - 

65 USED_ON_6 Sixth used on item - 

66 USED_ON_7 Seventh used on item - 

67 USED_ON_8 Eighth used on item - 

68 WEIGHT_UNIT 
Automatically filled out - toolkit 
application 

kg -

TABLE 3: PART PARAMETERS 

* These parameter values are required and are automatically generated from the FMTV start part and
assembly relations. 

3.12.1 The parameter CAGE_CODE refers to the original design activity.  If the current 

design activity is different than the original design activity then the current one is entered into 

the CURRENT_CAGE_CODE field.  A table must also be placed on the drawing showing the 

current design activity cage code (see sample below). 

FIGURE 2: CURRENT DESIGN ACTIVITY CAGE CODE
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3.12.2 The parameter REMARKS should initially default to PRELIMINARY.  This will 

automatically appear on the drawing until the value is removed during the final stage of the 

release process. 

3.12.3 The parameter NOMENCLATURE will automatically be assigned a value based upon 

FMTV start part relations.  The value is equal to the sum of the individual parameters 

NOMENCLATURE_1, NOMENCLATURE_2, and NOMENCLATURE_3, which shall be 

entered appropriately by the modeler. 

3.12.4 The part or assembly parameter UNIT_WEIGHT is automatically filled out by Creo 

Parametric (PRO_MP_MASS calculated parameter) when the part or assembly is regenerated. 

This is accomplished using relations found in the FMTV start parts.  The parameter value for 

unit weight shall be representative of the weight of its true physical counterpart. 

3.13 23BPart Units 
Creo Parametric system units shall match the following:  

Unit type METRIC ENGLISH 

Length mm in

Mass kg lbm

Time sec sec

Temp ºC ºF

TABLE 4: UNIT SYSTEMS

Note:  English and metric unit systems exist in the FMTV start parts 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV  

Page 17 13 February 2014 FMTV-MODELING-STD-100T  Rev.L 

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

4 Assembly Modeling Standards  

4.1 24BAssembly Modeling Practice 

4.1.1 Assemblies shall have all components and features of the assemblies defined, including 

pins, screws, nuts, washers, the part number etc.  This includes items such as decals, warning 

labels, bulk items, etc., which are required to be attached to the assembly. 

4.1.2 Assembly of models shall follow a logical sequence.  

4.1.3 Assembly features shall only be used for features manufactured at the assembly level and 

not  for features created on individual parts.  

4.1.4 All assembly models shall regenerate successfully with all features and components in 

the unsuppressed status.  When assemblies are modified, the next higher assembly shall also be 

capable of being successfully regenerated. 

4.1.5 All assembly components shall be fully constrained unless the function of the assembly 

benefits from adding certain degrees of freedom through connections.  The FIX constraint 

should avoid being used.  The use of Creo Mechanism joints, for example, is acceptable in this 

case. 

4.1.6 The latest FMTV_START_ASSY shall be used for assembly creation. 

4.2 25BTolerances 
Refer to Section 3.2 Tolerances. 

4.3 26BModel Notes 
Refer to Section 3.5 Model Notes. 

4.4 27BAssembly Default Datums 
All assemblies will start with default datum planes and a default coordinate system identical to those 

found in the FMTV start parts.  The default datum planes shall be named FRONT_ASSY,  

TOP_ASSY, and SIDE_ASSY.  The coordinate system shall be named ACS0 with its orientation as 

follows; Z axis is elevation, X axis is along the length of the vehicle, Y axis across the vehicle width. 
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4.5 28BAssembly File Names 
Assemblies shall be named using the following convention: 

          CAGE_PartNumber.asm i.e. 19207_12432300.asm 

For additional guidelines for assembly naming refer to Section 3.8 Part File Names. 

4.6 29BModel Views 
All models shall have separately named views defining the TOP_VIEW, BOTTOM_VIEW, 

LEFT_VIEW, RIGHT_VIEW, BACK_VIEW, FRONT_VIEW, and DEFAULT views. These views 

exist in the FMTV start part.  The FRONT view is oriented facing the yellow (or primary) side of the 

FRONT datum plane, with the yellow side of the TOP datum plane facing up.  The remaining 

orthogonal views follow standard third angle projection practice.  Current drawing models should be 

created such that the named views correspond to the existing drawing views.  When applicable, the 

addition of ROADSIDE and CURBSIDE views is recommended. 

4.7 30BAssembly Layers 
The following layers shall be used in assembly mode (these exist in the FMTV start assembly). 

Layer name Layer Assignments Default State 

a. ITEM_ID 
Only the cosmetic/curve feature describing the part identification 
number 

Hide 

b. DTM_AXES All datum axes Hide 

c. DTM_CSYS All datum coordinate systems Hide 

d. DTM_CURVES All curve features Hide 

e. DTM_PLANES All datum plane features Hide 

f. DTM_POINTS All datum point features Hide 

g. G_DTM_PLANES All geometric tolerancing datum planes Hide 
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h. NOTES All assembly notes Hide 

i. SURFACES All surface features and quilts Hide 

j. THREADS All cosmetic and actual threads Hide 

k. XSEC_DATUMS All cross-section datums  Hide 

TABLE 5: ASSEMBLY LAYERS 

4.8 31BBulk Items 

Bulk items are classified into two different categories.  These items will be referred to as TYPE 1 and 

TYPE 2 categories.  TYPE 1 bulk items are commodities that are used in a volume, such as adhesives, 

fluids, lubricants, etc.  TYPE 2 bulk items are cut to length or stock parts, such as seals, gaskets, 

convoluted tubing, tape, etc.   

TYPE 1bulk items are non-solid representations of objects within an assembly.  They shall be used for 

all objects that must appear in the Bill of Material or PARTS LIST but do not require solid models.  

Bulk items shall be used to represent adhesives, lubricants, sealants, paint, etc.  Bulk items are a unique 

subset of the .prt model type and are represented by a unique icon (paint can) in the Creo Parametric 

Model Tree.  New bulk items can be created by using the start_bulk.prt template in the Commonspace 

Templates folder. 

It is not acceptable to create a -500 suffix component of the base object in the assembly and add Table 

relations to overwrite the parameters reported in the columns.  The bulk item shall be created with the 

proper cage code, name, and description to automatically populate the table repeat region.  The typical 

table relation for bulk items relates the reporting the quantity which is typically set to "AR". 

TYPE 2 bulk items shall have a Creo Parametric 3D solid model to represent the item.  The models 

will either fall into the deformed/installed state or flexible component category. 

4.9 32BAssembly Parameters 

Follow the same guidelines as Section 3.12 Part Parameters. 
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4.10 33BRelations 
Relations shall have no errors upon regeneration. Relations found in feature ACS0 of the FMTV start 

assembly are required. 

4.11 34BSurface Finishes 
Surface finishes shall be created on the assembly as required. 

4.12 35BReference Objects 
Reference components displayed in phantom on installation or similar drawings should not be fully 

associated 3D models.  These should be developed using 2D curve data or 3D model data as required 

(refer to Appendix D.3 for 2D and Appendix D.4 for 3D Lightweight Backdrop Creation.   Any 

components specifically defined on the drawing must have a valid associative 3D model as per 

Paragraph 4.1.1. 

4.13 36BAssembly Units 
Follow the same guidelines as Section 3.13 Part Units. 
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5 Drawing Creation Standard 

5.1 37BDimensions 
Drawings shall display dimensions that are directly parametric to the model upon which they are 

based.  Specifically, these values shall be either driving or driven dimensions.  

5.2 38BGeometric tolerances 
Geometric tolerances shall be attached to the base dimensions when applicable and not added as 

unattached notes. 

5.3 39BFormats 
Standard FMTV 3D/TDP drawing formats located in the Standard CAD Template Library / Start Parts 

and Formats in Windchill PDMLink shall be used.  

5.4 40BDrawing Setup Files 
Standard FMTV 3D/TDP drawing setup files (.dtl) located in the Standard CAD Template Library / 

Configs in Windchill PDMLink shall be used. 

5.5 41BDrawing Standards 
The drawing standard used shall be ASME Y14.100-2013 and ASME Y14.5-2009.  These standards 

shall be called out in Note1 of the drawing model. 

5.6 42BNotes 
All notes on drawings shall originate as model notes in .prt and .asm files, except when deemed 

necessary.  
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5.7 43BDrawing Views 
2D draft entities shall be related to the drawing view to which it belongs.  Views shall be capable of 

being moved with no entities of the view being left behind. 

5.8 44BDrawing Line-Weights 
The following line weights and colors shall be used: 

COLOR STYLE ITEMS 

WHITE Normal Weight object lines, view arrows, format borders 

YELLOW Thin Weight leader lines, dimensions, notes, symbols, tables 

GRAY Phantom hidden object lines,  

RED Bold special lines needing extra emphasis 

WHITE Phantom Tangent Lines

TABLE 6: DRAWING LINE WEIGHTS 

5.9 45BQuality Assurance Information 
The preferred method for identifying Quality Assurance Information is on the product drawing instead 

of having a separate QAP sheet. 

5.10 46BDistribution Statement 
The drawing distribution statement shall appear on each sheet of a drawing.  (This is automatically 

accomplished when the model note Distribution_Note is filled out in the drawing model.)   

5.11 47BRevision Block 
Revision blocks shall conform to ASME Y14.35M 

5.11.1 For legacy conversion ECP’s, include only the latest revision, redrawn with 

change/redrawn without change and ECP number in lieu of full delineation of the changes on 
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the drawing for Administrative changes.  For individual Major or Minor changes, those 

changes shall be listed in the revision block.  

5.11.2 For design effort ECPs that make drawing changes the revision block shallincluding the 

latest revision, redrawn with change, ECP number and full delineation of the changes on the 

drawing. 

5.11.3 For design effort ECPs that release a new drawing the revision block shall include 

Initial Release, Product Baseline, and the ECP number.  

5.12 48BAssociated Models 
All parts that are defined by a drawing shall be related to the drawing even if they are not used in a 

view on the drawing. 

5.13 49BParameters 
The following parameters shall be filled out for the drawing model: 

 Part_Number

 Drawing_Date

 Drawn_By

 Modeler_Name_1

 Checker_Name

 Engineer_Name_1

 Material_Engineer

 Design_Approval_Name

 Nomenclature

 QA_Engineer_Name

 Drawing_Number

 Revision

 Distribution_Code

 Itar

 Err_Ecp_Number
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 Err_Ecp_Date*

 Err_Ecp_Approval*

*These parameters are not required to be filled out at the In Work state.  Their values shall  be
determined later in the release process. 

5.14 50BLayers 
Drawing layers may be created as required to properly display information on the drawing.  Layer 

status may be set (this works independent of the part/assembly) as required to properly display 

information on the drawing. 

5.15 51BFile Names 
Drawings shall be named using the following convention: 

          CAGE_DrawingNumber.drw   i.e.   19207_12428511.drw 

5.16 52BDrawing BOM Balloons 
BOM balloons will use a standard diameter of 0.375 inches (9.525 mm).  If the numbers within the 

balloon extend beyond the balloon then the size of the text will be decreased to best fit within the 

standard balloon.  Refer to Appendix C.13 for additional information. 
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6 Templates 

Creo Parametric object templates are used to customize the default content of newly created 

objects.  Object templates belong to one of two categories: model templates (also known as start parts) 

and drawing templates.  Model templates are standard Creo Parametric models that contain predefined 

features, layers, parameters, named views, and other attributes.  Drawing templates are special drawing 

files that contain instructions to create drawing items, including views, tables, formats, symbols, snap 

lines, notes, parametric notes, and dimensions.  Drawing templates are not currently used in the FMTV 

environment.  The basis for a drawing is the Creo Parametric format. 

6.1 61BStart Parts 
The start parts already contain a default coordinate system, default datum planes, views, layers, 

notes, relations, and parameters.  There are start parts developed for solid models, sheetmetal models, 

and assembly models as named below. 

 fmtv_start_part.prt

 fmtv_start_shtml_part.prt

 fmtv_start_assy.asm

 fmtv_start_diagram.dgm

The parameters that are part of the start models are listed below in Table 7, most of which are

required by the PdM-MTV 3D/TDP standards. 

Parameter Name Parameter Description Format Example Source 

AGENCY Agency or service US ARMY Relation

 AUTO_PART_NUMBER* Yes-No, Used in relation YES User 

CABLING_ASSY* Yes-No, Set to YES for Cabling assembly NO User 

 CAGE_CODE Original Design Activity CAGE Code 19207 Relation 

 CATALOG_NOMENCLATURE Nomenclature assigned by supply User 

CHECKER_NAME Person that checked original K.BALL User 

 CIRCUIT_NUMBER* Circuit Number used for Electrical J159 User 

CONTRACT_NUMBER Contract # - original design contract DAAE07-03-C-S023 User 

DESIGN ACTIVITY Design Activity (from relations) TANK AUTOMOTIVE & 
ARMAMENTS COMMAND 

Relation 

 DESIGN_ACTIVITY_LOCATION Design Activity City, State and Zip Code 
(from Relations) 

WARREN, MI  48397-5000 Relation 

DESIGN_APPROVAL_NAME Person who approved design A.TAYLOR User 
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 DESIGN_CONTRACTOR Original design contractor STEWART & STEVENSON 
SERVICES, SEALY TEXAS U.S.A. 

User 

 DISTRIBUTION_CODE Distribution Statement (A,B,C,D,E,X) A User 

 DRAWING_APPROVAL_NAME Person who approved drawing A.TAYLOR User 

 DRAWING_DATE Date original drawing created YY-MM-DD User 

 DRAWING_NUMBER Drawing Number 12423205 User 

DRAWN_BY Person who created original drawing J.WENNER User 

 ENGINEER_NAME_1 Primary design engineer A.WURFEL User 

 ENGINEER_NAME_2 Secondary design engineer J.ZEBROWSKI User 

 ERR_ECP_APPROVAL Approving official of latest ECP N.TAUBE User 

 ERR_ECP_DATE Date current revision released YY-MM-DD User 

ERR_ECP_NUMBER ECP that caused current revision TACV1234 User 

ITAR Controlled by International Traffic in 
Arms Regulation 

YES User

 JEWEL_BEARING Yes-No Parameter, contains jewel bear NO User 

MATERIAL_ENGINEER Person who OK’d material for design M.CHURCH User 

MATL_CLASS Automatically filled out (from relations) User 

MATL_GRADE Automatically filled out (from relations) User 

 MATL_HEAT_TREAT User 

 MATL_NAME User 

 MATL_SHAPE User 

 MATL_SPECNO User 

 MATL_TYPE User 

 MATL_UNS_NO User 

MC_ERRORS ModelCHECK number of errors 0 User 

MODELER_NAME_1 Primary Pro/E modeler J.WENNER User 

 MODEL_CHECK ModelCHECK last run on object YY-MM-DD User 

 NEXT_ASSY_1 First next higher assy part no. (must match 
Used_On_1 above) 

12419847-001 User

NEXT_ASSY_2 Second next higher assy part no. User 

NEXT_ASSY_3 Third next higher assy part no. User 

NEXT_ASSY_4 Fourth next higher assy part no. User 

NEXT_ASSY_5 Fifth next higher assy part no. User 

NEXT_ASSY_6 Sixth next higher assy part no. User 

NEXT_ASSY_7 Seventh next higher assy part no. User 

NEXT_ASSY_8 Eighth next higher assy part no. User 

 NOMENCLATURE Part Name BODY ASSEMBLY, CARGO, MTV 
LWB 

Relation 

NOMENCLATURE_1 First Nb_1 characters of Nomenclature 
(for drawing) (from rel) 

BODY ASSEMBLY, User 

NOMENCLATURE_2 Second Nb_2 characters of Nomenclature 
(for drawing)(from rel) 

CARGO, MTV LWB User 

NOMENCLATURE_3 Remaining characters of Nomenclature 
(for drawing)(from rel) 

User

OZONE_DEPLETING_CHEMICAL Yes-No Parameter, Ozone depleting 
chemical 

NO User
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 PART_NUMBER Item part number 12423205 Relation 

 PIPING_ASSY* Yes-No Parameter, set to YES for NO User 

PMIC Precious Metal Indicator Code A User 

PTC_COMMON_NAME* PTC Common Name User 

 QA_ENGINEER_NAME Quality Assurance engineer P.FIESTER User 

 REMARKS General Remarks PRELIMINARY User

 SOURCE_CONTROL Yes-No Parameter, Source Control NO User 

 SPEC_CONTROL Yes-No Parameter, Spec Control NO User

SPEC_NUMBER Specification Number (SPEC Parts Only) ASME B18.2.1 User 

 SPECIALTY_METAL Yes-No Parameter, Specialty Metal NO User 

 TOLERANCE_1_PLACE Default tolerance if indicated on drw .1 User 

 TOLERANCE_2_PLACE Default tolerance if indicated on drw .05 User 

 TOLERANCE_3_PLACE Default tolerance if indicated on drw .030 User 

 TOLERANCE_ANG Default tolerance if indicated on drw User 

UNIT_WEIGHT Mass computed in Creo Parametric 1.25 User 

USED_ON_1 First used on item FMTV A1R User 

USED_ON_2 Second used on item User 

USED_ON_3 Third used on item User 

 USED_ON_4 Fourth used on item User 

USED_ON_5 Fifth used on item User 

USED_ON_6 Sixth used on item User 

USED_ON_7 Seventh used on item User 

USED_ON_8 Eighth used on item User 

WEIGHT_UNIT Unit - Weight kg Relation 

TABLE 7: OBJECT PARAMETERS 

* Non-Designated Parameters

6.2 62BFormats 
PdM-MTV standard formats have been created to work with the PdM-MTV start parts.  These 

formats are available in the Windchill PDMLink / STANDARD CAD TEMPLATE LIBRARY / Start 

Parts and Formats.  These are the only formats that shall be used when creating new or updating old 

drawings for the FMTV database.  These formats are named using the following convention: 

(Drawing Size)_(Vehicle Family)_(Unit System)_(1)_(Version) 

 b_fmtv_met_1_5.frm

 c_fmtv_eng_1_5.frm

 c_fmtv_met_1_5.frm

 d_fmtv_eng_1_5.frm

 d_fmtv_met_1_5.frm

 e_fmtv_eng_1_5.frm

 e_fmtv_met_1_5.frm

 f_fmtv_eng_1_5.frm

 f_fmtv_met_1_5.frm

 d_fmtv_diag_1_1.frm

 e_fmtv_diag_1_1.frm
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7 Electrical 

7.1 116BSchematics 

7.1.1  Schematic File Names 

Schematic naming convention shall follow the format below: (Note: Schematics are used for 
reference to drive the overlay that is contained on the production drawing) 

CageCode_PartNumber 
Example: 

19207_12506185.dgm 
19207_12506185-001.dgm (For tabulated harnesses.) 

7.1.2  Schematic Overlay Process 

Schematics shall be created using an overlay process.  This procedure will insert an overlay of 

the diagram into the drawing.  When an overlay is used, anytime a diagram updates or changes, 

it will change on all drawings where the overlay exists.  Overlays will not create a snapshot in 

time of the present state of a diagram, it will update with any changes parametrically.   

Overlays will also require that the formatting be turned off in the diagram and the diagram saved 

in that condition.  If it is not turned off, there will be noticeable differences in the title blocks and 

formatting.  The formatting in a diagram is different from that of a drawing. 

The overlay will need to be placed on a blank sheet in the drawing.  This can be used to bring 

diagram data into the drawing and relay the changes in the diagram to the drawing, but revisions 

will not be possible from within the drawing.  Use the rev block from the drawing to track the 

changes for the diagram on the overlay sheet. Alternatively, the user can create a rev block in the 

diagram to force the information to be updated in the diagram.  It also keeps the diagram ready 

to be printed independently.  The rev block that would be on the blank sheet in the drawing gets 

deleted to prevent a duplicate rev block from showing on the drawing.   
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145BDiagram Setup: 

 Turn off the page formatting on the sheet to be overlaid.

 Place a rev block on the diagram (This is only needed if the rev block from the drawing is not

utilized)

The diagram may need BLANK sheets added for the automatic tables to be populated with the 

correct sheet number. 

146BDrawing Setup: 

Insert a blank sheet where the overlay should appear. 

Delete the rev box from the new blank sheet; the diagram rev box will be used. 

Insert the diagram overlay. 

147BHow to Insert an Overlay 

Select Tools > Overlay 

Select Add Overlay 

Select Place Sheet 

Select the diagram file to be inserted 

Select Open 

If the diagram is more than 1 sheet, it will ask which 

sheet to insert. 

Converting a Schematic that was previously Stand-Alone to Overlay 

If a schematic already exists in the system as a standalone 19207_SC12345678.dgm file, the 

following process should be used to incorporate the schematic into the drawing. 

1. Rename the schematic from 19207_sc12345678.dgm to 19207_12345678.dgm
2. Create a DUPLICATE OBJECT of the existing schematic and name it

19207_sc12345678.dgm (This is needed since the original, newly renamed, schematic will
still drive the drawing; however a schematic is needed to document the superseded schematic
from a CM perspecitve).
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3. On the DUPLICATE OBJECT schematic, add SUPERSEDED BY 12345678 above the title
block and update the rev block to state that the schematic was superseded and incorporated
into drawing 12345678.

4. Follow Creating a Diagram Overlay method.

7.1.3  Spool File Requirements 

Spools should only be checked in by a Spool administrator. Only Spool administrators have the 
rights to check items into the Spools folder and create or modify Spools within this folder.  All 
Spools should be checked in and stored in the Routed Systems/Spools LIBRARY in 
Commonspace. 

Spool naming convention shall follow the format below: 
CageCode_PartNumber (Government Part Number or Spec Number) 

Example: 
19207_12423132-004.spl (Government Part Number) 

 81349_M16878/14BJE9.spl (Spec. Number) 

Spool files shall include the following parameters: 

Parameter Name Parameter Description Used On Example Value 

Name 
Mil Spec Number of Governement Number of the 
wire, tubing, etc… 

All Spools 
19207_12420924-
001 

Cage_Code Cage Code used to fill BOM Table. All Spools 19207 

Description Description used to fill BOM Table. All Spools 
Electrical, 18 AWG, 
White 

Units Unit of Measurement All Spools mm/inch 

Mass_Units Unit of Measurement All Spools kg 

Density Density All Spools kg/mm^2

Color 
Color of the cable, wire insulation, or sheathing 
(See Table 20) 

All Spools White 

Color_Code Code for the Color (See Table 20) All Spools WHT

Insul_type Insulation Type 
Wire/Cable 
Spools 

GXL 

Wire_Gauge Wire gauge 
Wire/Cable 
Spools 

18 AWG 

Min_Bend_Radius 
The minimum radius a wire/cable/sheath can 
bend. 

All Spools 8 

Thickness The diameter of the wire/cable. 
Wire/Cable 
Spools 

2 

Number_of_Conductors The number of conductors in a cable. Cable Spools 5 

Sheath_Type Specifies the type of sheathing for this spool. Sheath Spools Tape, Tube, Shrink 

Outer_Diameter Indicates the outer diameter of the tube sheathing. Sheath Spools 12 

Preshrink_Inner_Diamete
r 

Indicates the pre-shrunk diameter of SHRINK 
sheathing. 

Sheath Spools 10 

Wall_Thickness Indicates the thickness of the sheathing. Sheath Spools 0.5 

Width Specifies the tape width for tape sheathing. Sheath Spools 20 

TABLE 8: SPOOL FILE PARAMETERS 
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Not all parameters will be used depending on the type of spool used. Use all of the 
parameters above when applicable. 

Color Color Code 
White WHT
Black BLK
Red RED
Blue BLU

Green GRN
Yellow YLW
Orange ORG
Gray GRY

Violet VLT
Brown BRN

Tan TAN
Pink PNK

Table 9: Color Code References 

7.1.4  Schematic Spacing  

Schematic shall use the minimum spacing required to prevent overlapping while being clearly 
visible when printed on an A size sheet. 

7.1.5  Schematic Tables 

Schematic shall include a wire run table showing the following information: 
Circuit, Wire, From, To, Color, Color Code, Gauge, Insulation, and Description. 

Use table diagram_circuit_list.tbl located in Commonspace 

FIGURE 3: DIAGRAM_CIRCUIT_LIST.TBLE EXAMPLE 

7.1.6  Schematic Circuit Numbers 

Schematic circuit numbers shall follow the numbers assigned in document 12506111.  Circuit 
numbers that are used multiple places require an alpha-extension. (Example: 90-A, 90-B…) 

7.1.7  Circuit Description 
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Circuits shall show the circuit number, gauge, and color code on each wire. Circuit description 
shall come from document 12506111. 

FIGURE 4: CIRCUIT DESCRIPTION EXAMPLE 

7.1.8  Reference Designators 

Schematic reference designators shall follow the numbers assigned in document 12506111. 

Common Reference Designators 
Designator Description Example 
CBXX Circuit Breakers CB01
TLXX Terminal Lugs TL01
EXX Splices E01
PXXX Male Connector P101
JXXX Female Connector J101
TBXX Terminal Box TB01
KXX Relays K01
SXX Switch S01

Table 10: Common Reference Designators 

7.1.9  Connector Description 

Connectors shall show the reference designator, connector function, and pin-out orientation on 
every connector.  Refer to Figure 5 

FIGURE 5: CONNECTOR EXAMPLE 
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7.1.10  Phantom Box Requirements 

Phantom boxes shall be used when a system or sub-system is shown in a simplified form. 
Phantom boxes require a label of 6.35 mm (.25 inch) height that describes the sub-system and 
shall use the phantom line type. Refer to 6 

FIGURE 6: PHANTOM BOX EXAMPLE 

7.1.11 Schematic Symbols 

Schematic symbol text orientation shall be primarily left to right and secondary bottom to top. 
The symbol should be descriptive and should show reference designators and pins. When printed 
on an A size print, the symbol should be clearly visible. 
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7.1.12 Twisted Pairs/Shields 

Twisted Pair wires shall be shown as needed per design intent, while shields should always be 
shown. (Refer to Figure 7: Rigid or Smooth lines are acceptable) 

FIGURE 7: TWISTED PAIR(S) EXAMPLE - RIGID VS. SMOOTH 

7.1.13 Splices 

Butt splices, not through splices shall be used when splicing wires.  
Note: Splices are a manufacturing process and not a part. 

7.1.14 Wire Breaks 

Wire breaks shall be depicted as follows, with the text indicating (SH.#, REF_DES).   

(Refer to Figure 8) 

FIGURE 8: WIRE BREAK EXAMPLE 

7.1.15 Schematic Layout 

The schematic should flow from left to right. 

7.1.16 Top-Level Schematics 

Top-level schematics shall be organized by function; meaning one function per page. (Example: 
ABS, CTIS). Phantom box section above applies to top-level schematics. A visual representation 
of connector contact gender shall be shown. 

7.1.17 Start Part (Diagram) 

Refer to Section 6.1 - Start Parts 
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7.1.18 Formats (Diagram) 

Refer to Section 6.2 – Formats 

7.1.19 Schematic Diagram File 

The schematic diagram file shall be promoted along with the drawing and models.  The 

parameters for the diagram file shall match those of the drawing and models.  The schematic 

revision shall also match the revision of the drawing where the overlay is located on. 

7.1.20 Source Control Drawing Schematics 

At a minimum, an Interface Control Diagram shall be included on Source Control Drawings; 

however, a schematic is preferred when sufficient data is available. 

7.1.21 Drawing Properties 

Diagram files shall use fmtv_diagram_1_1.dtl to provide correct setup for diagram 

7.2 117B2D Drawings 

7.2.1  Tables  

Two Dimensional drawings shall include a Bill of Material table listing all components used and 
showing reference designators. Also, a harness variation table shall be shown listing all harness 
variations. harness_bom.tbl (or harness_drawing_table.tbl) table (Figure 9) can be utilized 
which is located in Commonspace.   
Some relations may have to be written in order for the table to look correct.  Two tables are 
listed as either can be used based on preference. 

FIGURE 9: HARNESS_BOM.TBL SAMPLE 
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7.2.2  Connector Pin Position  

Connector pin position shall be shown from the front face and label as the front. Reference 
designator and function shall be shown as required. Empty terminals will be plugged per 
12420908. 

7.2.3  Connector Description 

Connector reference designators and function/description shall be shown. All connectors shall 
show all components with pin outs.  

7.2.4  Harness Dimensions 

Harnesses shall be dimensioned from connector front face, centerline of bundle, or center of 
eyelet. Dimension units are vendor specific. 

7.2.5  Two Dimensional Drawing Notes 

Two Dimensional Drawings shall include the following notes: 

 SCOPE AND GENERAL REQUIREMENTS FOR
MANUFACTURING AND ACCEPTANCE OF ELECTRICAL
CABLE ASSEMBLIES SHALL BE IAW DRAWING
12420908. 

 DIMENSIONS WITHOUT TOLERANCES SPECIFIED ARE
FOR REFERENCE ONLY AND SHALL NOT BE USED FOR 
INSPECTION PURPOSES. 

 ITEM IDENTIFICATION: APPLY THE FOLLOWING
MARKING IAW MIL-STD-130,
CAGECODE-PARTNUMBER-REV
MFR-          MANUFACTURER'S CAGE CODE
DATE MFR YYYY/MM/DD

 ALL CIRCUIT NUMBERS AND REFERENCE
DESIGNATORS SHALL BE IAW 12506111.
(This note is used ONLY if the drawing has a schematic located on it)

 Any note required to show design intent or to clarify the manufacturing process.
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7.2.6  Splices 

Splices locations shall be dimensioned and noted with the reference designator. 

7.2.7  2D Harness Drawing Nomenclature  

 Harness - A combination of wires, cables, connectors, and/or related components.
 Cable Assembly - Multiple conductors, single sheath between two connectors.
 Generic names are no longer acceptable (i.e. No drawing shall be titled CABLE

ASSY)

7.2.8  2D Harness Layout 

When a harness has too much detail to show on a single page, detailed views shall be used on 
additional pages. 

7.3 118B3D Harness Modeling 

7.3.1  Naming Convention 

Refer to SECTION 3.8 - Part File Names as 3D harnesses follow the standard naming 
convention 
Sample Naming Convention: 
The naming convention follows the following format for Routed Electrical Harnesses  
(Note: do not use the same extension for an assembly and a part) 

19207_12345678-600.asm (Routed Assembly) 
19207_12345678-601.prt (Harness Part, within Routed Assembly) 
19207_12345678-650.mfg (Manufacture Part) 
19207_12345678-651.asm (Flat Harness Sub Assembly) 
19207_12345678-652.asm (sub-assembly in the manufacture part) 

7.3.2 Connectors 

Connector assemblies shall be used for connectors requiring other components (I.E. contacts, 
plugs, TPA…) Connector assembly names shall follow the following convention: 

CageCode_HarnessNumber-ReferenceDesignator.asm  
 (i.e. 19207_12345678-J01.asm) 
Connector entry ports shall be named according to the pin name. For example if the pin is “1”; 
the entry port shall be named “PORT_1” or if the pin is "A"; the entry port shall be named 
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"PORT_A". ("ENTRY_PORT" is also acceptable for generic ports) Refer to Figure 10 for 
example 

FIGURE 10: CONNECTOR ASSEMBLY EXAMPLE 

7.3.3  Interferences 

Wiring interferences are only acceptable within its own harness part.  
Enclosures: All wires should be contained within the box. Multiple harnesses are allowed to 
intersect within the enclosure only if interference is unavoidable.   

7.3.4  Logical Reference 

3D harness models shall be “driven” by a schematic and not created without reference to a 
schematic. 

7.3.5  Splices 

19207_Splice.prt shall be utilized, the part is located in the / STANDARD CAD TEMPLATE 
LIBRARY / Start Parts and Formats folder in Commonspace. 
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7.4 119BElectrical Checklists 

Harness Assembly Checklist 

Harness Assembly 

File Name:  CageCode_HarnessPartNo-600.asm 

Skeleton Name:  CageCode_HarnessPartNo_skel.asm (Skeleton is NOT required, applies to all steps 

below) 

All connector assemblies are assembled to a coordinate system in the harness skeleton part 

The harness path coordinates, points, and axes are all in the skeleton part 

All harness parts (i.e. band markers, ….) are assembled to a coordinate in the skeleton part 

The correct layers have been created in the assembly following the modeling standards 

All unnecessary layers are hidden in the skeleton and assembly 

The assembly and skeleton were created using the correct start part 

The skeleton features have names that represent each features purpose, i.e. a coordinate system for a 

connector is named using the reference designator of the connector. 

Band markers have been placed behind the connectors following the manufacturing standards 

The harness identification marker has been placed 

Splices have been attached to a location point on the harness network 

The correct splice part has been used, splice.prt 

The harness assembly does not have any interference with objects along the routing path and does not 

interfere with other harnesses.  Wiring interferences within the assembly are acceptable. 

The correct assembly structure was used, following all the electrical modeling standards 

Is the unit weight accurate and reasonable for the harness 

All parameters have been completed 

Model check has been completed on this assembly 
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Connector Assemblies 

File Name:  CageCode_HarnessPartNo-RefDes.prt 

Skeleton Name:  CageCode_HarnessPartNo-RefDes_skel.prt (Skeleton is NOT required, applies to all 

steps below) 

All connector parts are assembled to a coordinate system in the skeleton part 

Entry port coordinate systems are named Port_# and are located in the main assembly 

Entry port coordinate systems have the positive z axis pointing out of the connector base 

The correct layers have been created in the assembly following the modeling standards 

All unnecessary layers are hidden in the connector skeleton and assembly 

The assembly and skeleton were created using the correct start part 

The skeleton features have names that represent each features purpose, i.e. a connector refdes 

The connector assembly includes all parts that are needed for the connector assembly 

Nomenclatures match the harness assembly with the refdes included for each connector assembly 

Correct assembly structure was used following the electrical modeling standards 

Correct cage code was used on any new connector parts, i.e. manufacturer cage codes 

Model check has been completed on each connector assembly 
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Harness Part 

File Name:  CageCode_HarnessPartNo-600.prt 

Logical reference has been established 

All connectors and components have been designated as cabling components 

All entry ports have been designated 

All wiring features have been created from the logical reference 

A network has been created for the harness part’s routing path (optional) 

All wires and cables have been routed and marked complete 

Bundles representing convoluted tubing and insulation sheathing have been created and routed 

Bundles have been accurately created following manufacturing standards 

All non cabling components have been attached to the harness part, i.e. band markers, … 

All Spools needed for the harness, i.e. wires, sheaths, and tapes, have been read into the harness 

The harness part was created using the correct start part 

No cosmetic cabling features have been created in the harness, i.e. tape or markers. 

The correct layers have been created in the assembly following the modeling standards 

Model check has been completed for this part.  (Part must be opened from Pro/INTRALINK) 
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Detail Drawing Checklist 

Drawing File Setup 

Correct format has been used. 

Title block information is correct without spelling errors 

Verify correct distribution and proprietary notes are used from 782 form 

Distribution and proprietary notes are place on all sheets in the correct locations 

Drawing title accurately represents the harness, it is not a generic title 

Default part is the lower level flattened harness assembly. 

There are no drawing items interfering with the rev block or standard notes area 

The correct layers are in the drawing and hidden 

Model check has been completed on the drawing 

Harness Layout and Views 

A full layout view has been placed with overall dimensions 

Detailed views are used for branches with several connection points 

Harness scale is large enough to recognize the connectors and components 

View is oriented to show the flat harness correctly 

Cable display is set to thick on each view of the harness 

No hidden lines are displayed within a view 

Connector pin out views have been placed next to each connector 

Harness Dimensions 

Dimensions along the main trunk are created from a single starting point on the main trunk 

Branch Dimensions are created from a single starting point from the main trunk 

Dimensions are from the face of the connector to the breakout starting location 

Dimensions for ring terminals are from the center of the eyelet to the breakout starting location 

There are no stacked dimensions along a branch or the main trunk 

Dimensions match those specified by the engineer, may require overwritten dimensions 

Splice locations are dimensioned.  If several are in one area, a detailed view should be used 

All components along a path have a dimension to reference their location 
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BOM Table and Balloons 

BOM balloons are auto generated for all non cabling parts in the harness 

BOM balloons for cabling components have been manually created, i.e. wires, tapes… 

BOM balloons are separated for all occurrences of a component 

BOM balloons are merged to a single leader line if several are present for a single component 

BOM balloons should clearly mark where different wire spools are used 

Use 3-region BOM table: Bottom region is the flat assembly, middle region is harness part, and top region 

is the 3D harness assembly. 

Items not needed in the table are filtered out of the table 

BOM Table has been sorted by reference designators 

Notes and Rev Block 

Notes and Revision information should be generated in the lower level flat harness assembly. 

Notes have been created from the standard notes library 

All connectors will have a functional description 

All connectors, components, and splices are labeled with their reference designator 

The drawing contains the minimum required notes  (See below) 

Any special requirements for manufacturing or installation have been noted on the drawing 

Minimum Required Notes: 

APPLICABLE STANDARDS/SPECIFICATIONS: 

   A.  ASME Y14.100-2013 

   B.  ASME Y14.5-2009 

IEEE/ASTM SI 10 SHALL BE USED 

IN CONVERTING AND ROUNDING OFF. 

1 INCH = 25.4 mm APPLIES. 

SCOPE AND GENERAL REQUIREMENTS FOR 

MANUFACTURING AND ACCEPTANCE OF ELECTRICAL 
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CABLE ASSEMBLIES SHALL BE IAW DRAWING 

12420908. 

ITEM IDENTIFICATION: APPLY THE FOLLOW 

MARKING IAW MIL-STD-130, 

   CAGECODE-PARTNUMBER-REV 

   MFR-         MANUFACTURER'S CAGE CODE 

DATE MFR YYYY/MM/DD 

DIMENSIONS WITHOUT TOLERANCES SPECIFIED ARE 

FOR REFERENCE ONLY AND SHALL NOT BE USED FOR 

INSPECTION PURPOSES. 

ALL CIRCUIT NUMBERS AND REFERENCE DESIGNATORS SHALL BE IAW 12506111. 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 45 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

Diagram Checklist 

Sheet Setup 

Correct format (e_fmtv_diag_1_2.frm) 

Electrical_Diagram DTL File has been loaded or Start Template is used 

All parameters for the diagram are completed 

Grid set to 6mm Spacing 

Snap to Grid is on when placing wires and components 

File Name is CageCode_PartNo.dgm 

Nomenclature 3 is set to “SCHEMATIC” 

Scale set to NONE 

Weight set to ----- 

Diagram has been checked for spelling errors 

All Layers are hidden. 

Connectors & Symbols 

Connectors have a unique reference designator, verified with the standards… 

Connectors have complete parameters, read in from a library file 

Connector pin designations are centered and the Reference Designator is at the top or left 

Connectors have 12mm pin spacing and/or single pin connectors are resized to 26mm 

Connectors and symbols have a description/function note 

All connection nodes are on the grid 

Symbols have a reference designator assigned and displayed 

Symbols have complete parameter files, read in from a library file if available 

Correct splice symbols are used 

All connectors and symbols have Entry Ports entered in the parameters 

Connectors are aligned and organized on the sheet 
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Wires & Cables 

Wires and cables are using the correct spool file 

Wires and cable conductors have a circuit number assigned, verified with the standards… 

Wires have a functional description added in the DESC parameter 

Wires have a parametric note for the description at the connector pin 

Wires are organized neatly on the sheet with as few crossovers as possible 

Wire labels and wire descriptions are spaced 1 grid away from the connector 

Wire labels are aligned with one another at the connector 

Wire label format:  Circuit#-Gauge AWG -ColorCode 

Wire break symbols are aligned 

Wires are spaced evenly and aligned on the grid 

Wire labels are readable and have no interferences 

Twisted wires are shown using jogs and aligned with one another, along the same side of the sheet 

Cable Symbols are used to indicate cable assemblies 

Cable conductors are assigned correctly in the cable 

Tables 

Circuit run table has been placed (diagram_circuit_list.tbl in common space) 

Text in table cells is visible, column with is adequate to display contents 

Verify that no information is missing from table and all circuits have completed parameters 
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Notes and Revision Block (No longer needed with OVERLAY format) 

Required Diagram Notes have been placed (See Below) 

Rev Block has been completed, correct format 

Revision level matches the drawing and assembly 

Distribution note has been placed 

Proprietary note has been placed, if required 

Distribution and Proprietary notes match the 782 form and the drawing 
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Example of a Schematic Layout: 
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8 Piping 

8.1 120BGeneral Overview 
Piping assemblies shall be created in a way that maintains a Stand Alone status. The fittings 

and/or components used to set the start and end points of a route shall be able to be deleted or changed 

at any time without causing a problem / failure to the pipe. The pipes shall not be dependent on the 

top-level assembly where they will be installed.  If this is not done the pipe can collapse or change with 

the slightest modification to a fitting or a coordinate system (CS0) at a later time.   

Piping routes shall be created in their own separate Creo Parametric assembly file to break any 

ties to the master assembly. Isolating the piping routes keeps the routes and all of its extensions 

separate and contained. The new piping assembly is created using the FMTV_Start_Assembly file. A 

part shall be fabricated later using the same base part number with "_p" and the extension of .prt. This 

part file is a dependent of the assembly file and is created from the pipe route in the assembly file. 

The piping assembly file shall be fully constrained in the upper level assembly.  The actual 

constraints are left to user discretion.  Components and CS0s shall be placed to set the start and end 

points for the route.  Components such as fittings may be constrained to vehicle geometry to set initial 

locations, but require an edit definition to break the association to existing geometry in order to 

establish a standalone model. 

Note: All Piping Assemblies and Line Stocks shall be created in METRIC units only.   
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8.2 121BLine Stock Overview 
A Line Stock file contains the shape, size, and material needed to be projected along the piping 

path in the fabrication process.  The Line Stock file defines the physical attributes of the hose. 

Material and mass properties are defined with the Line Stock file and shall not be duplicated by 

entering material specification into the material file of the part.  The minimum bend radius of the hose 

shall also be defined in the Line Stock file. 

Line stocks should be pulled from the / STANDARD CAD TEMPLATE LIBRARY / Routed_Systems / 

Line Stock LIBRARY in Commonspace.  The Line Stock folder is controlled by Line Stock 

administrators.  Only Line Stock administrators have the rights to check items into the Line Stock 

folder and create or modify Line Stocks.  All Line Stocks shall be checked in and stored in the Routed 

Systems/Line Stock folder in Commonspace; see Figure 11. 

FIGURE 11: COMMONSPACE FOLDER STRUCTURE

Naming Convention of Line Stocks: 

 Each file is created in the master library and is named according to the MIL specification or

-SAE number in addition to the diameter size and type; see Figures 12 & 13.

FIGURE 12: SAE LINE STOCK EXAMPLE FIGURE 13: MIL SPEC LINE STOCK EXAMPLE 
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 If no specification is available, the new line stock should be named after the part that is using

the pipe.  This may be applicable to Source Control Drawings.

 If the type and size of line-stock does not exist in Commonspace, send the line stock

specification to a line stock administrator so it can be created.

 The Line Stock is assigned first in the set-up process of creating a route; see Figure 14.

FIGURE 14:LINE STOCK CREATE / READ

NOTE: Line Stocks shall be done in METRIC units. 

Use Create to make a new line stock. 

Use read to load an existing line stock.  Do a 
search in common space first and checkout the 
Line Stock that is required.  Never change or 
modify existing line stocks. 
Notify a member of the Line stock admin of 
any errors in line stocks in Commonspace. 

Use "Write" to write a Line 
Stock into a local workspace. 
Line Stock admin's are the 
only people who can use this 
function. 
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 Line Stocks contain information that is directly related to the pipe part; see Figures 15, 16, and 17.

FIGURE 15: LINE STOCK SET-UP

Minimum Bend 
Radius in mm 

Line Stock Type 

This is the weight per 
length of the hose or tube. 
This number is provided 
from the manufacturer or 
spec. callout in kg/mm. 

Section Type can be set to Solid or Hollow 
depending on user preference.  This will not 
affect the Weight/Length outcome. 
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FIGURE 16: LINE STOCK DESIGN RULE PARAMETERS
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FIGURE 17: LINE STOCK DEFINED TAB

User Defined Parameters for 
writing relations in special cases. DRAFT
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A Line Stock can also be created with a .txt file in Notepad or similar program. The following 

example shows all of the parameters needed to create a Line Stock; see Figure 18. 

FIGURE 18: .TXT FILE OF A LINE STOCK
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8.3 122BCreating Routes / Pipelines  
Pipe assemblies have a specific naming convention.  A pipe assembly name is a combination of 

the upper level assembly name and the pipe circuit number called out in the installation schematic. 

The circuit number can be found in the schematic related to the installation.  For example, for a pipe 

assembly named 19207_12345678-6110.asm, the upper level assembly is 12345678 and the circuit 

number is 110, and the hose size is .375".  The pipe assembly is designated as a pipe by the "6" as the 

first character in the dash number.  Piping installations that are complex should have accompanying 

schematic drawings.  If a schematic is not provided, circuit numbers shall be defined within the 

installation drawing. 

If a circuit number is not provided, then one must be created.  This is done by selecting the next 

available number that has not already been used in the current piping installation. The circuit number 

should be a three digit number.  The three digits represent the hose type or size and should be 

described in a table within the drawing.  For example, the first number in pneumatic assembly circuit 

numbers is used to designate either bulk tubing or crimped hose, and also to distinguish the bulk tubing 

size.  A sample pneumatic circuit number table is shown below; see Table 11.  

Circuit Identification Hose/Tubing Type 

0XX .25 Inch Bulk Tubing 

1XX .375 Inch Bulk Tubing 

2XX .50 Inch Bulk Tubing 

3XX .625 Inch Bulk Tubing 

5XX Hoses with Crimped Ends 

8XX Hoses with Crimped Ends 

TABLE 11: CIRCUIT ID TABLE 

NOTE: All bulk tubing sizes are outer diameter and all rubber hose sizes are inner diameter. 
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 The fmtv_start_assy.asy has four parameters (see Table 12) that are dedicated to Pro/PIPING 

that should be filled out in piping assemblies.  These parameters are PIPING_ASSY, 

HOSE_LENGTH, WEIGHT_PER_LENGTH, and CIRCUIT_NUMBER.  Piping assemblies should 

have the PIPING_ASSY parameter set to YES.  The default value is NO.  The 

WEIGHT_PER_LENGTH parameter should be filled in with the numeric value of the weight/length 

given in the line stock file used in the piping assembly.  When this is done, the HOSE_LENGTH 

parameter will be filled in automatically.  The CIRCUIT_NUMBER will also be automatically 

generated as it takes the last 3 digits of the filename and fills in the parameter. 

 If the PIPING_ASSY parameter is set to YES, the PART_NUMBER parameter will need to be 

filled out manually.  The PART_NUMBER parameter in the piping assembly will be filled in with the 

part number of the hose or tube it represents, i.e., the part number should be the number of the part that 

would be purchased from a BOM.  The piping assembly is just a 3-D representation of that part in its 

routed state.  The PART_NUMBER parameter is the number that will be listed on the assembly 

drawing.  For example, if a pneumatic piping assembly 12345678-6130 represents a piece of 3/8" bulk 

tubing, with the part number 12420572-006, the FILE_NAME of the pipe assembly will be 12345678-

6130 and the PART_NUMBER will be 12420572-006.  The CIRCUIT_NUMBER parameter would 

automatically be filled in with 130 in this instance. 

The following are four specific parameters in the fmtv_start_assy.asm that supports Pro/PIPING 

Parameter Name Parameter Description Format Example Input 

01 PIPING_ASSY 
YES/NO parameter. Defines if the 
assembly is a piping assembly 

YES -

02 HOSE_LENGTH 
Automatically generated when 
PIPING_ASSY is set to YES.  

12.5 -

03 WEIGHT_PER_LENGTH 
Numeric value of the weight/length given 
in the line stock file (manually entered, 
should be same as line stock file) 

..00417 -

04 CIRCUIT_NUMBER 
Automatically generated. Provides 3 digit 
circuit number 

110 -

TABLE 12: PIPING ASSEMBLY SPECIFIC PARAMETERS
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Port creation: 

 Ports should always have the Z-axis orientated in the direction of pipe flow; see Figure 19.

FIGURE 19: SAMPLE HOSE FLOWING INTO PORT AND Z-AXIS DIRECTION 

 The Z axis of the pipe port should be collinear to the Z axis of the fitting port.

 The centerline of the pipe needs to remain collinear to the Z axis of the fitting port beyond the

termination point of the fitting.
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 The user will determine the actual routing of the pipeline.  There are many ways to route each

pipeline and each user will have a preferred method.   Two methods are shown in Figure 20.

FIGURE 20: EXAMPLE OF CREATING PIPE ROUTE IN SEGMENTS VS. FOLLOWING CURVE 
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8.4  123BFittings and Other Piping Parts 
Fittings should be created / updated to include an entry port for each connection point; see Figure 21.  

FIGURE 21: TWO EXAMPLES OF A SAMPLE TEE FITTING W/ ENTRY PORTS 

 Entry ports shall follow the naming convention of PORT*, i.e., PORT1, PORT2, or PORTA,

PORTB, etc.

 The Z-axis of an entry port shall point out of the fitting; pipelines enter or exit the fitting

parallel to the Z-axis.

 The entry port should be where the pipe or hose terminates.

 Piping parts such as tie wraps, convoluted tubing, adhesive, etc. should be created and

assembled as bulk items.
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FIGURE 22: CREATING PIPELINE 

8.5 124BFabricating / Creating Solid Pipes 
Fabrication features create the actual part using the path and line stock as its guide.  The 

FMTV_Start_Part shall be used as a template.   

Once a part is fabricated it creates a separate .PRT file.  The fabricated pipe can be opened 

individually when updating the layers. 

Note:  When fabricating a part, use the same -6xxx extension as the assembly with the addition of the 

"_p". (e.g., 12345678-6123_p.prt) 

1) Select Fabrication & Pipe Solid from the piping menu shown in Figure 22; a new window
will open.

2) Select the fmtv_start_part in the Copy From box at the bottom of the window;
see Figure 105.

3) Expand the pipe route in the left hand center section of the window; see Figure 23.

4) Highlight the pipe segment under the pipe route; see Figure 23.

5) Add the new solid pipe name into the Solid Pipe parameter of the pipe segment;
see Figure 23.

6) (e.g. 19207_12345678-6123_p)

7) Select fmtv_start_part under the Start Part parameter of the pipe segment; see Figure 23.

8) Select Make, then OK; see Figure 24.

1 
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FIGURE 23: FABRICATING PIPELINE 

FIGURE 24: FABRICATED PIPELINE 

The pipe solid is now created; see Figure 24 
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3 
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5 & 6
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1

2 

3 

4

Figure 25 shows a standard pipe assembly with two fittings:   

1. Create  a pipe assembly with the correct naming convention

2. Assemble your fittings within the pipe assembly
a) Fittings should only be included in the piping assembly if they are permanently attached

to the hose, i.e., if the hose has crimped on hose ends.

3. Read the Line Stock into the assembly

4. Create a path for the individual pipe using a user's preferred method

5. Fabricate the pipe

FIGURE 25: SAMPLE PRO/PIPING DRAWING TREE 

Note: Straight_Point is not a 

necessity as the modeler can 

use Set Start at each port and 

extend from each to keep the 

pipe straight entering into the 

fitting. 

5 
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8.6 Pipe Centerlines 
The centerline for pipes shall be layered off in the drawing.  This can be accomplished by 

creating a new layer titled PIPING_BLANKED_LAYER or by placing them on the DTM_CURVES 

layer. 

8.7 125BSchematics 
Schematics are required for any complex piping installation drawing and shall follow the 

naming convention below; 

CageCode_PartNumber 

Example: 

19207_12505846.dgm 

19207_12505846.rsd 

A complex piping installation drawing is defined as containing more than five piping 

assemblies constrained within that corresponding installation.  Those piping drawings of insufficient 

complexity should have the piping routes and information defined in the installation drawing rather 

than in a schematic.  For those assemblies of sufficient complexity, a schematic should be referenced 

in the notes on the installation drawing. Pro/DIAGRAM or Routed System Designer (RSD) may be 

used to create the schematic.  A schematic is not required to be parametrically linked to the piping 

installation or drawing and should be used for reference purposes. If the schematic is part of the 

drawing, the overlay process in section 7.1.2 can be used. 

Schematics should consist of: 

 Schematic Line Connection List; see Figure 26
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FIGURE 26: SAMPLE SCHEMATIC LINE CONNECTION LIST 

 Symbol Legend; see Figure 27.

FIGURE 27: SYMBOL LEGEND EXAMPLE 

 A Color Legend for the diagram; see Figure 28.
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FIGURE 28: COLOR LEGEND EXAMPLE 

 Piping diagram; see Figure 29.

FIGURE 29: SAMPLE PIPING DIAGRAM 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 67 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

Installation drawings that do not have associated schematics should include a Line Connection 

List in the installation drawing.  This list defines the circuit ID for the routed pipes within the 

installation. 

Note: All circuits are labeled with proper identification numbers as described in section 8.3, table 11 and 

components (symbols) are labeled with required reference designators that correspond with Figures 24 

and 25. 
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8.8 126BPiping Checklists 

Pro Piping Checklist 

Piping Assembly 

File Name:  CageCode_PipeAssyNo-6XXX.asm 

The circuit identification matches the specific type of hose or tubing designated on the required circuit 

number table. Refer to section 14.3, table 22 

The correct line stock has been used. 

The correct layers have been created in the assembly following the modeling standards 

All unnecessary layers are hidden in the assembly 

The assembly was created using the correct start assembly. 

There are no external references 

Piping parameters (PIPING_ASSY, HOSE_LENGTH, WEIGHT_PER_LENGTH, PART_NUMBER) to be 

filled out properly. 

The correct assembly structure was used, following all the piping modeling standards 

Is the unit weight accurate and reasonable for the pipe assembly 

Appropriate parameters have been completed 

Model check has been completed on this assembly 

Centerline has been layered off  

Pipe Part 

File Name:  CageCode_PipeAssyNo-6XXX_p.prt 

Logical reference has been established 

Centerline has been layered off  

The piping part circuit number matches the up assembly circuit number 

All unnecessary layers are hidden in the part 

Material file should not be called out 

Is the unit weight accurate and reasonable for the pipe part 

Appropriate parameters have been completed 

The piping part was created using the correct start part 

The correct layers have been created in the part following the modeling standards 

Model check has been completed for this part. 
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Diagram Checklist 

Sheet Setup 

Correct format (e_fmtv_diag_1_2.frm) 

Appropriate parameters for the diagram are completed 

File Name is CageCode_PartNo.dgm or CageCode_PartNo.rsd 

Nomenclature 3 is set to “SCHEMATIC” 

Scale set to NONE 

Weight set to ----- 

Diagram has been checked for spelling errors 

All Layers are hidden. 

Tables 

Schematic Line Connection List, Symbol and Color Legend have been placed 

Text in table cells is visible, column with is adequate to display contents 

Notes and Revision Block 

Required Diagram Notes have been placed (See Below) 

Rev Block has been completed, correct format 

Revision level matches the drawing and assembly 

Distribution note has been placed 

Proprietary note has been placed, if required 

Distribution and Proprietary notes match the 782 form and the drawing 

Required Diagram Notes 

1. APPLICABLE STANDARDS/SPECIFICATIONS:

   A.  ASME Y14.100-2013 

   B.  ASME Y14.5-2009 

2. SCHEMATIC IS IAW DRAWING 19207_XXXXXXXX
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A Modeling Best Practices 

A.1 63BPart Mode 
 Name features appropriately.

 Patterns and pattern table use is recommended

 Sheetmetal parts shall always be created by starting with the standard fmtv_start_shtml_part.prt

start part.

 Save models early and often.

 Base features should be kept simple.

 Sketches should be kept simple.

 Incomplete features must be removed or completed.

 Relations should be clearly commented.

 Round/chamfer edges should generally not be used as references for other features.

 Rounds and chamfers should be created as late as possible in the modeling process.  Draft

features should be created when most appropriate.

 Datum planes make the best sketch planes and references.

 Extruded feature depth definitions should reflect the design intent such that the depth remains

appropriate if the part is modified.

 When modeling from an existing drawing, try to create the models with features and

dimensions that limit the need for created dimensions on the drawing.

 Create new datum planes and axes for use as Geometric tolerance datums and axes.  (Do not

rename the default datums found in the start part or use axes created by a feature.)

 Add geometric tolerance datums to the G_DTM_PLANES layer immediately after using the

“Set Datum” command in Creo Parametric.

A.2 64BDrawing Mode 
 Standard FMTV formats (in Standard CAD Template Library) must be used on drawings.  The

correct standard format version depends on the work effort.

 Standard drawing setup files (.dtl) must be used.  These are applied when the appropriate

Drawing Options are used.
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 Snapshots should not be used unless absolutely necessary.

 Drawings shall not contain overwritten dimensions unless required.  For more information see

the Poor Modeling Practices in Appendix B.

 Views should be oriented using saved views or default datums, not model geometry.

 All notes symbols, and other 2D sketched entities should be related to the appropriate view or

object.  (HINT: To check for this move the view(s) to see that no entities of the view are left

behind.)

A.3 65BAssembly Mode 
 The first component or skeleton is the structural base for assembling all other components.

 Individual components or sub-assemblies should be colored differently for ease of viewing,

textures should avoid being used as they can slow down regeneration time.

 Components should be fully constrained with an appropriate combination of constraints (ex.

MATE, ALIGN, INSERT, COORDINATE SYSTEM, etc...).  An exception to this rule is

components assembled using PTC Creo Mechanism. These components are allowed degrees of

freedom to simulate the movement of desired parts in an assembly. When PTC Creo

Mechanism is used a snapshot shall be stored in order to locate the “at rest” design position.

The FIX constraint should be avoided as a normal constraint as it was designed to finalize the

location of moved or packaged components where the final location is not yet known.  The FIX

constraint will also hinder the use of Local Groups in Assembly.
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B Poor Modeling Practices 

The following section explains how to avoid/work around several examples of poor modeling 

practice. 

B.1 66BBuried Features 
Filling in holes/cuts with a protrusion is not acceptable.  Occasionally ModelCHECK reports 

cuts as buried features if the definition of the subtracted volume lies entirely within the existing solid. 

This is an allowable buried feature. 

B.2 67BOverwritten Dimensions 
It is not acceptable to overwrite a dimension with @o in order to change the numeric value 

from that which is defined in the model.  Overwriting to show another character that may be found in a 

table (i.e. A, B, C, etc.) is acceptable.  The preferred method in this case would be to modify the 

symbolic value of the dimension and show it using @s on the drawing.  

B.3 68BBlind Feature Depth (= to material thickness) 
When creating an extruded feature where the depth is intended to be through the part, the depth 

shall not be entered as a numeric value equal to the material thickness of the part.  The depth shall be 

set using thru all, thru next, or up to surface as appropriate.  Example: a cut is created through a part 

but the depth is entered as a value equal to the material thickness of the part, the feature does not 

update as desired if the material thickness is increased.  If thru all were to be set as the defined feature 

depth, the feature updates as expected when the part thickness is changed. 

B.4 69BExcess Datums/Features 
Extra, unused datums shall be cleaned up/removed from models.  When modeling a part or 

assembly, datums are created for construction of the part.  Often some of these datums are not actually 

required in the final iteration of the model.  These datums shall be removed when possible.  Remaining 

features shall then be named as appropriate (i.e. naming a datum plane CL_PART if this is the intent). 
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When a part datum is to be used for assembly purposes, be sure to name it so as to recognize its 

purpose and to avoid accidental deletion.  (i.e. ASSY_1) 

B.5 70BView Name and Scale Not Parametric 
The displayed view name and scale should be parametric to the model.  If these are accidentally 

removed at some point, attempt to “show” them in the drawing instead of keying in non-associative 

text. 

B.6 71BBending Back Using the Wrong Sheetmetal Surface 
Be sure after creating an unbend feature to use the correct surface when creating the bend back 

feature.  If the same surface is not selected, dimensions will not “show” properly on the drawing. 

B.7 72B“0” Offset Assembly Mate 
Unless an assembly constraint of Mate or Align requires the value of zero to make the design 

flexible, it should be fixed as Coincident. 

B.8 73BCongested Sketches 
If a part has several dimensions defining its shape, these shall be broken up in to an appropriate 

number of separate features.  When roughly 10 or more dimensions are used to create a base feature 

the sketch can become congested and difficult to work with.  When roughly 20 or more dimensions are 

found in a sketch, the computational time becomes cumbersome as well as the sketch being congested.  

B.9 74BFlat pattern for Sheetmetal parts 
Sheetmetal parts should not be created by starting with a flat pattern.  Sheetmetal parts should 

be modeled in an “as designed”, functional state.  The flat pattern is created last (as necessary) for 

manufacturing purposes, using Edit>Setup within the sheetmetal application.  This creates a separate 

flat instance which can be added to the drawing as a model independent from the generic fully formed 

model used on all other views.  The fully formed generic model may be changed and features added or 
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deleted.  As long as the family table is verified regularly, the flat patter will automatically update with 

the changes done to the generic. 
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C Miscellaneous Topics, Methods and Techniques 

C.1 75BModel Relations 
Each model has relations that can be found in part, feature, and sketch levels.  Feature relations 

take precedence over part relations as they occur later in the regeneration cycle.  Relations found in 

feature CS0/ACS0 of the FMTV start parts are required.  These should not be changed from what is 

contained in the start part. 

C.2 76BAssembly Relations 
(d#:# or d#:cid_#) 

When part dimension symbols are shown in assembly mode, they contain two numbers (d#:#). 

The first number is assigned from within the part and is the same number that will be seen if the 

symbol was viewed from Part mode.  The second number is assigned from within Assembly mode and 

is the number that appears in the assembly coding table.  This second number can also be found by 

selecting Show > Session Id in the Relations dialog box.  Creo Parametric will return, Component 

<component_name> has Session ID #.  Each part in the assembly is assigned a unique second number 

but components with the same name will have the same Session ID. 

Assembly relations that include family table components can also be written in the format 

(d#:cid_#).  The first number is still the same dimension number that was assigned at the part level but 

"cid" is the Internal Component ID.  The Internal Component ID is found by selecting Show > Info in 

the Relations dialog box.  The Internal Component ID is unique for every component even if the same 

component is assembled twice in the same assembly.  This method would be preferred if the same 

component is assembled twice in the same assembly, a relation is written using the dimensions of the 

component and then one of the components is replaced using Edit > Replace.  Using the Internal 

Component ID will ensure that the relation will update as intended.   
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C.3 77BPROGRAM – From File vs From Model 

The From File menu selection will be displayed only if the original PROGRAM has been 

modified and there is text file of the program residing in the current working directory.  If From File is 

chosen, the editor will display the most recent listing of the program that resides on the local disk. 

The From Model menu selection will extract the current listing associated with the object. 

Upon initial creation of a PROGRAM, the user will not see these two choices, as Creo Parametric will 

use the default listing associated with the model.  After modifying the model file, then storing it to 

disk, the user will be asked if he or she wishes to incorporate any changes.  If the changes are 

successfully incorporated, the model will be update accordingly and the design file will be deleted, 

once again leaving only the default model listing.  

C.4 78BCreo Parametric Layers 
Layers are helpful in controlling the display of features, layers, and components in the Creo 

Parametric environment.  Entities are assigned to a layer and layer display status is set.  Entities 

created when using the FMTV start models are automatically set to the appropriate layer.  The two 

exceptions are cross section datum planes and GTOL datum planes.   Additional layers may be created 

as necessary to help organize things such as construction geometry, imported data, etc. 

Display status may be set at different levels, for example: part, assembly, skeleton, and 

drawing. Drawing display status acts independent of part, skeleton, and assembly layer settings.  The 

stored layer status will vary as appropriate for objects being worked on.  When a part or assembly is 

promoted into the release process its layer status must follow the modeling standard.  The layer status 

of a drawing should be set as required to show entities appropriately on the drawing.  Isolate status is 

often useful as explained in the datum target point example described in the following paragraph. 

An entity may be set to more than one layer.  This should be done as little as possible since the 

only way to see the entity is to turn on all of the layers it resides on or to set one of them to isolate 

status. For example, if an item is on two or more layers and any one of them has a hidden status, the 

item will not be displayed.  If a point feature is placed on three different layers (dtm_points, 

inspection_points, and datum_target_points) the datum target points may be seen by settings the 

datum_target_points layer status to isolate.   
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NOTE:  Setting the layer to isolate status displays entities on the layer regardless of the layer status of 
other layers it resides in. 

The following image shows the layers found in the FMTV start part.  Note that the display 

status is hidden for all layers.  This is how archived objects are set so that the screen is not cluttered. 

FIGURE 30:  LAYER TREE 

FIGURE 31: SETTING VISIBILITY OF LAYERS 
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It is acceptable to have layers unhidden as long as the config.pro and config.sup options listed 

in FMTV Creo Configuration Settings prevent the screen from being cluttered upon initial retrieval of 

a part, assembly, or drawing.  

If a feature(s) on a layer(s), such as those generated by datum curves or a set datum operation, 

displays despite these options being set then those layers must be hidden or the feature in question 

must be moved to a layer that is controlled by the above config.pro options 

C.5 80BGeometric Dimensioning and Tolerance (GD&T) used in Creo 
Parametric 
Per the TV modeling standards, geometric tolerance is required to be applied to three-

dimensional part and assembly models using Creo Parametric commands.  The Insert > Annotations 

> Geom Tol menu showing these commands is found below. 

FIGURE 32:  INITIATE GTOL 

Step 1 - Identify existing datums (or create new ones) to be used in constructing the datum 

reference plane.  Set the appropriate datums using the Set Datum command from the menu 

above.  
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Step 2 - Specify dimensions as basic as required.  These dimensions made basic by using the 

Basic Dim command from the menu above. 

Step 3 - Specify dimensions as inspection as required.  These dimensions made inspection by 

using the Inspect Dim command from the menu above. 

Step 4 - Describe features of size (such as holes and slots) with a feature control frame.  The 

feature control frame is created using the Specify Tol command from the menu above.  The 

geometric tolerance window appears as shown below.  Select the button of the appropriate 

geometric characteristic (i.e. position, concentricity, etc.) at the left hand side of the window. 

Select the reference as required (ex: An edge for a straightness tolerance).  Assign the new 

tolerance if it is to appear in a dimension (ex: A hole diameter dimension for a position 

tolerance.) 

FIGURE 33:  GTOL MODEL REFERENCES TAB 

Click the Datum Refs tab and then select appropriate primary, secondary, and tertiary datums 

as references (if required).  Make sure to set the proper material condition also. 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 82 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

FIGURE 34:  GTOL DATUM REFERENCES TAB 

Click the Tol Value tab and enter the necessary tolerance value if required. 

FIGURE 35:  GTOL TOLERANCE VALUE TAB 

Finally, click the Symbols tab and select any required symbols, modifiers, additional text, or 

projected tolerance descriptors. 
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FIGURE 36:  GTOL SYMBOLS TAB 

C.6 81BDatum Planes and GTOL  
Datum planes will not appear in the list of possible datums to reference in the Datum Refs 

portion of the Geometric Tolerancing dialog box unless they have been set.  To set a datum, select Set 

Datum from the GEOM TOL menu, select the axis or plane to set, and then choose the placement 

type for the datum from the Datum dialog box (Free or In Dim).  Once the datum is set, it will be 

available for referencing.  The datum plane must also exist and be stored in the model showing the 

Model field of the Models Refs portion of the Geometric Tolerance dialog box. 

IMPORTANT: In order to delete a datum that has been set as a GTOL datum, it should first be cleared 
using the Edit > Set Up > Geom Tol > Clear menu selection. 

C.7 82BGTOL Datum Features Visibility  
By default, all set datums will be displayed regardless of the existing display setting for datum 

planes. This is true in parts, assemblies and drawings.  For parts and assemblies, the only way to 

remove the set datum is to place the datum on a layer and hide the layer.  This is why it is required that 

the modeler assigns set GTOL datums to the g_dtm_planes layer so that they may be turned off while 
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modeling.  In drawings, the set datums may either be turned off using the layer controls or erased using 

the View > Show/Erase > Erase > Datum > Selected Item command. 

C.8  83BModelCHECK Process 
ModelCHECK is used to compare the active part, assembly, or drawing to a set of required 

configuration settings and report back items that are not set properly.  It provides tools to help correct 

the deficiencies. 

C.8.1 ModelCHECK Procedures 

ModelCHECK will be run interactively in a Creo Parametric session by each individual 

designer.  The designer will perform the task on each model/drawing he or she has worked on.  Report 

viewing will be accomplished using the built in Creo Parametric browser.  Run ModelCHECK by 

either clicking on the ModelCHECK Interactive Button from the Analysis pull down menu in the pull 

down as shown below or using the MCK mapkey. 

FIGURE 37:  INITIATING MODELCHECK 

A report summary will appear in the browser window that will look similar to Figure 38. 
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FIGURE 38:  MODELCHECK SUMMARY 

In order to view the detailed information, click on the tabs at the top of the browser (Info, 

Param, Layer, Feat, Relat, Datum, and Misc).   By default only errors and warnings are displayed. 

In order to view general information and checks the check boxes next to the icons must be selected, as 

shown in Figure 39 (numbers next to the icons show the number of related items). 

FIGURE 39:  MODELCHECK TYPES

Error Warning Info Pass 
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FIGURE 40:  EXAMPLE OF MODELCHECK REPORT 

NOTE: Any errors found must be corrected.   Any warnings found should be investigated. 
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Clicking on any of the tabs makes that report page active.  Clicking on the line number displays 

a detailed description of the error or warning.  Certain quick corrections, such as creating missing 

layers and correcting layer status, can be made by ModelCHECK.   It will take a few moments each 

time a button is selected for the action to take place in the Creo Parametric session.  After fixing all 

errors run ModelCHECK again to make sure all items have been fixed.  ModelCHECK will not save 

the model or check it in to Commonspace; the user is required to complete those tasks when 

appropriate. 

C.8.2   FMTV ModelCHECK Error/Warning Summary  

ModelCHECK is currently configured to operate in the interactive mode as described in the 

ModelCHECK procedures.  Any checks made resulting in errors must be fixed or the model may not 

be promoted in Windchill PDMLink.  When ModelCHECK is run the following checks will result in 

an error: 

1. Features 1-4 must match those found in the corresponding start part.

2. No suppressed or incomplete features may be found in models.

3. No frozen, suppressed, missing, and/or packaged components may be found in assemblies

(except when PTC Creo Mechanism is used).

4. Density must not be equal to “1” (ensures that a material file has been applied).

5. Features must be assigned to appropriate layers (by corresponding entity type).

6. All parameters found in the current start part/assembly must exist and be designated.

7. All layers found in the current start part/assembly must exist.

8. All views found in the current start part/assembly must exist.

9. Insert mode may not be active.

10. Length and mass units must correspond with those in the start parts.

11. Unused drawing sheets are not allowed.

12. Any dimensions in drawings that may not be regenerated are not allowed.

13. Drawing format must be current.

14. The ModelCHECK ignore function may not be used.

15. Relation Check
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Any checks resulting in a warning shall be investigated, as they are case dependant occurrences. 

When ModelCHECK is run the following checks will result in a warning: 

1. Model name shall be equal to #####_*.  (Checks that the file name begin with five numbers

and an underscore).

2. Relation errors shall not exist.

3. In general, erased drawing views shall not exist.

4. Round children (features that are children of rounds) are not advised as design best practice.

5. Overwritten dimensions in drawings are not advised as a drawing best practice.  In certain

instances they are required though, such as when showing dimensions for a family table part

where values A, B, C, etc. are required.

6. Draft feature children are not normally a design best practice.

7. DTL file settings shall match standard settings.  If several items don’t match the standard

settings, this may indicate that the wrong .dtl file is applied to the drawing.

C.9  84BGeometry Checks 
Creo Parametric issues a “geometry check” warning when a model is regenerated to indicate 

that there may potentially be some risk with the model’s geometry.  Geometry Check is a warning of 

potential risk, but does not guarantee that there will be any problems with the model.  Currently there 

is no explicit indication of the severity of a geometry check.  

Examples of a reported geometry check include: 

A geometry check warning of a tiny edge detected.  The geometry check probably doesn’t 

affect the model accuracy or a drawing of said model.  Some risk is present regarding the export of 

“clean data” There is also a small amount of risk that further design changes may put the model at risk 

of failure. 

1. Assess Risk:
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Factors that may be used to determine the risk associated with a geometry check include: 

 Location

 Anticipation of Design Modifications

 The Use of Downstream Applications:  Including the use of shared data features and the

export of model data for simulation, analysis, and manufacturing.

 Quality of Design Techniques:

2. Investigate solutions:

Alternatives for resolving geometry issues include: 

 Redefine the affected feature so the Geometry Check does not occur.  This may be as

simple as creating a Sketcher constraint to align an edge to a vertex instead of having the

geometry driven by a dimension.  In more complex cases, the elements of the feature may

need to be redefined (for example, by making a round using Surf-Surf instead of Edge

Chain.)

 Create the geometry with a different type of feature to allow more control over the explicit

referencing of existing geometry.

 Change the order of feature creation.  For example, create a round feature earlier in the

feature list instead of near the end.

 Create the geometry with multiple features instead of one, or vice versa.  This may allow

more explicit control over the references or shapes of the features involved.

 Finally, there may be the possibility that the geometry has been created according to the

design intent and there seems to be no way to avoid the Geometry Check.

3. Implement the best solution:

Choose the most efficient and appropriate solution from above. 

C.10  85BMapkeys 
See FMTV Creo Parametric Configuration Settings 
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C.11  86BSymbols 
Symbols are located in the Standard CAD Template Library / Symbols.  They will also appear 

in the default User Symbol directory in Creo Parametric.  The list of available symbols in 

Commonspace can grow as more are created.  Separate sites can also create their own specific symbols 

and stored outside of Commonspace if so desired. 

C.12  87BSkeletons and Assemblies 

C.12.1   Scope 

Skeletons are models that are used for managing and building assemblies for installation and 

configuration models and drawings.  The skeleton is comprised of datum curves, points, surfaces, axes, 

and coordinate systems but no solid features.  The skeleton shall have a base coordinate system that 

corresponds with the vehicle coordinate system (Refer to Appendix E) .  The addition of multiple 

skeletons to build complete vehicle configurations is allowed.  Skeletons will generally look like a 2D 

or 3D “stick figure” sketch with many points, axes and coordinate systems.  The skeleton needs to 

have the necessary information to locate the components “in body” for a given installation.  For several 

Installation drawings, the components are spread out all over the vehicle, and constraining the 

individual components by other means can be very time consuming and not robust.  

C.12.2   Method 

Each installation model shall contain a coordinate system corresponding with the vehicle three 

dimensional reference system which is oriented with the ‘x” direction running along the centerline of 

the vehicle with “+x” going rearward, “+y” going to the curbside and “+z” going up.  

The installation model should be built on a skeleton with the primary components tied directly 

to the skeleton.  Sub-components that attach to a primary component will be mated to that primary 

component.  For example: a bracket assembly that mounts to the frame will be assembled with 

skeleton constraints while the hardware and other components mounted to the bracket assembly will be 

mated using assembly constraints to the bracket assembly. 
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The skeleton constraint shall be a coordinate system (CS) created for a unique component and 

renamed in the model tree as “part number” for that particular component.  If more than one 

component of the same name will exist in the same skeleton, either rename the CS with the part 

number followed by consecutive numbers (part number-2) or if it is a symmetrical application, use -LH 

or -RH behind the part number.  By constraining the coordinate systems at assembly the component 

will be in the correct location in the assembly.  

It is essential to have a corresponding coordinate point in the component being assembled to 

the skeleton.  The desired coordinate system for the component would be the default CSO so that 

creation of additional coordinate systems would not be necessary.  If a unique coordinate system is 

required, rename it as part-number_ASSY_CSYS.  The renamed coordinate system identifies that the 

coordinate system feature was created for a skeleton assembly and shall not be deleted from the file. 

The coordinate system for a component must be made to a feature on the component that is not likely 

to move.  

The creation of the coordinate system may require additional datum curves, axes, or datum 

planes for proper creation.  If so, in both the skeleton and the component, rename them so that a 

modeler will not accidentally delete them at another time.  Other information to keep in mind: 

 The skeleton will remain behind the scenes in the drawing and shall not be included in the BOM.

 The skeleton can be either a single model or an assembly of multiple skeletons.

 The skeleton naming convention uses the _skel series and should be related to the assembly for

which it is being created.  For Example: the skeleton for 57K2033 is named 57K2033_skel

 Skeletons shall be layered off/hidden so they are not displayed when viewing assembly they are

used in.
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C.12.3   Example of an Installation assembly using Skeletons: 

FIGURE 41:  BEGINNING WITH SKELETONS 

FIGURE 42:  2D CURVES AND CSYS FOR ASSEMBLY 
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FIGURE 43:  IMPORTED PHANTOM GEOMETRY 

FIGURE 44:  COMPONENT PLACEMENT DIALOG BOX 

CS in skeleton 
assembly 

CS for component 
DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 94 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

FIGURE 45:  TOP VIEW OF CAB ASSEMBLY

FIGURE 46:  REAR VIEW OF CAB ASSEMBLY 

View of completed 
assembly from the 
top looking down at 
the roadside of the 
cab 

View of completed 
assembly from the 
bottom looking up 
towards the roadside 
of the cab 
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FIGURE 47:  COMPLETED DRAWING - CAB SIDE VIEW 

FIGURE 48:  COMPLETED DRAWING - CAB TOP VIEW 
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C.13   88BInstallation “Split Balloon” Find Number Technique 

C.13.1   Scope 

This is the required method of identifying components on an assembly or installation using the 

parametric BOM in Creo Parametric.  The split balloon has the Find Number on the upper hemisphere 

and the Quantity on the lower hemisphere.  Within Creo Parametric, the option for this balloon is “with 

Qty” when selecting the balloon region.  This technique allows components with multiple instances to 

maintain the total quantity in the BOM as the balloons are disseminated across the drawing.  The 

default places one balloon for each find number with all quantities assigned to that one balloon.  The 

balloons can then be separated between views and pages and maintain the proper quantities for each 

balloon in each view or balloon location. 

There is a command named split, which means to split the base balloon into separate balloons 

and is not to be confused with the term split balloons. 

For reference part callouts on an assembly, reference balloons are the required method for 

identifying reference components.  Use appropriate method to create parametric reference balloons as 

required by Creo Parametric.  The one exception is if the reference item is from a component not 

contained in the Bill of Material, then a flag callout shall be used for reference. 

FIGURE 49: REFERENCE BALLOON FORMAT 
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C.13.2   Procedure 

1. Retrieve the table sbpartslist.tbl (or sbpartslist_spec.tbl) into the drawing.

FIGURE 50:  STEPS TO INSERT SPLIT BALLOON TABLE 

FIGURE 51:  SPLIT BALLOON TABLE 

The left 
column is for 
the Find No. 

The right 
column is for 
the Quantity  

The upper 
hemisphere 
identifies the 
FIND NO.  

The lower 
hemisphere 
identifies the 
Quantity  
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2. The Parts List Table will automatically fill out with the contents of the BOM.

FIGURE 52:  COMPLETED SPLIT BALLOON BOM TABLE 

C.13.3   Split Balloon Callout Generation 

The split balloons are created by selecting: 

Table > BOM Balloons > Set region > with Qty and select the Parts List table region, and then Done.   

Go to the primary drawing view, and on the Tables > BOM Balloon tab select Show and select the 

primary view.  The balloons show up automatically. 

To divide the balloons up into smaller quantities, (while still in the BOM Balloon drop-down 

menu) select the split command and select the balloon to be divided, and enter the amount to be taken 

out of the total quantity from the base balloon.  Then at the prompt, select the new component location 

to have the balloon and pick the location for that balloon.  

This portion of the procedure is the same for other methods, but the quantity remains visible and 

parametric to the system generated BOM table.  
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From this point, the balloon manipulation sequences (detach, merge and redistribute) work the 

same as other balloon methods.  

 Example of Split Balloon callouts for the table shown in Figure 53 below: 

FIGURE 53:  EXAMPLE OF SPLIT BALLOONS ON DRAWING 

C.13.4  Split Balloon Callout for Multi-Configuration BOM Report Table 

In a Creo Parametric drawing, an assembly drawing format can be modified so the BOM 

Report Table reflects multiple configurations of an assembly.  This can be based either on family table 
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instances or separate assemblies.  The preferred method is to create multiple BOM tables with each 

instance having its own table. 

C.13.5   Split Balloon Callout for Bulk Items 

Bulk material items such as convoluted tubing, strip foam seal tapes and other items that are cut to 

different lengths and have possible different installed state models but have the same part number need 

to be shown in the PARTS LIST TABLE as a single Find Number. In order to do this, several steps are 

required, including relations in the PARTS LIST and created split balloons. 

1) Parts List Table needs to be set to recursive to the appropriate level

2) The additional Find numbers need to be Filtered out of the Table

3) A relation is written against the Parts List Table to show the total cut length of the bulk
item 

4) The split balloons for the filtered find numbers are created (dummy) using the Find Number
of the totaled bulk item still in the Parts List

In the example below, there are several different sizes of convoluted tubing being used and in 

multiple quantities. (F/N 41, and 44 thru 49). The lengths of the tubing are also different and the 

“shape” of the installed state tubing models are different. 

FIGURE 54: UNFILTERED BOM FOR BULK TUBING

The PARTS LIST Table was filtered to remove find numbers 46 thru 49, yielding one Find Number 

item for each size (dash number) of the convoluted tubing. The total length of the respective tubing 

sizes were totaled up in the PARTS LIST for the quantity.  

FIGURE 55: FILTERED BOM FOR BULK TUBING

The cut length for each item is identified next to the split balloon at each location in the installation. 
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FIGURE 56: BULK LENGTH DEFINE IN VIEWS
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The split balloon callouts for the 41, 44 and 45 find numbers were created with a symbol since these 

belonged to the filtered out find numbers. The software cannot generate the balloons for these items so 

the balloon symbols have to be used.  (NOTE: The symbol may be called BOM_SPLIT_BALLOON 

also in the Library) 

FIGURE 57: SPLIT BALLOON SYMBOL

NOTES: 

1) The quantity for each split balloon shall be 1 and the cut length designated either beside or

below the balloon. The reason for this is to clarify the cut length for each item and to insure that

the correct item is used in the designated location.

2) The total length of the bulk material for all locations is indicated in the quantity column in the

Parts List along with the unit of measure as a relation to replace the actual unit quantity.
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FIGURE 58: RELATIONS FOR THE CUT LENGTH IN THE PARTS LIST 

C.13.6   Empty Table Space – Removing Part # 

137BWhen a part is removed from a PARTS LIST and not replaced with an equivalent part, the find 

number for where the part was removed shall be replaced with an empty table space.  To achieve 

this, use one of the ten available empty_table_space_#.prt parts located in the Standard CAD 

Template Library / Start Parts and Formats.  The empty_table_space_#.prt model is a bulk item 

and a relation will have to be written in the parts list on the drawing as shown below: 

138Bif asm_mbr_name == "EMPTY_TABLE_SPACE_1" 

139Bfinal_name = " " 

140Btqty = " " 

141Bendif   
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C.14   89BCreo Parametric pen table settings (default) 
See FMTV Creo Parametric Configuration Settings 

C.15  90BPDF print settings 
See FMTV Creo Parametric Configuration Settings 

C.16   91BPM-MTV Default configuration file settings  
See FMTV Creo Parametric Configuration Settings 

C.17  92BAnnotation Features 

Annotation features  are data features that can be used to manage the model annotation and 

propagate model information to other models.  An annotation feature consists of one or more 

Annotation Elements.  Each Annotation Element can contain one annotation item, along with 

associated references and parameters.  The following types of annotations can be added using the 

Annotation element:  

 Note

 Symbol

 Surface finish

 Geometric tolerance

 Reference dimension

 Driven dimension with tolerance

C.18  93BRelations (default) 
The relations built into the start part are Feature Relations.  The relations can be accessed by 

selecting Tools > Relations and then setting the type to Feature and then selecting the default 

coordinate system CSO.  Table 14, shown on the following page, lists the current state of relations for 

the start parts. 
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/*  START OF FMTV START PART RELATIONS 

/*  DO NOT DELETE OR MODIFY ANY LINES IN THIS SECTION 

/*  LAST MODIFIED: 30 NOV 2004 

/* 

/*  RELATION TO COMBINE NOMENCLATURE LINES 

/* 

nomenclature= nomenclature_1 + " " + nomenclature_2 + " " + nomenclature_3 

/* 

/*  RELATIONS TO ASSIGN DESIGN ACTIVITY AND DESIGN ACTIVITY LOCATION 

/*  BASED ON CAGE_CODE 

/* 

AGENCY="US ARMY" 

IF CAGE_CODE == "19200" 

   DESIGN_ACTIVITY="ARMAMENT RESEARCH, DEVELOPMENT AND ENGINEERING CENTER" 

   DESIGN_ACTIVITY_LOCATION = "PICATINNY ARSENAL, NEW JERSEY  07806-5000" 

ENDIF 

IF CAGE_CODE == "19204" 

   DESIGN_ACTIVITY="ROCK ISLAND ARSENAL" 

   DESIGN_ACTIVITY_LOCATION = "ROCK ISLAND, ILLINOIS " 

ENDIF 

IF CAGE_CODE == "59678" 

   DESIGN_ACTIVITY="ARMAMENT RESEARCH, DEVELOPMENT AND ENGINEERING CENTER" 

   DESIGN_ACTIVITY_LOCATION = "ROCK ISLAND, ILLINOIS 63299-5000" 

ENDIF 

IF CAGE_CODE == "19207" 

   DESIGN_ACTIVITY="TANK AUTOMOTIVE & ARMAMENTS COMMAND" 

   DESIGN_ACTIVITY_LOCATION = "WARREN, MICHIGAN  48397-5000" 

ENDIF 

IF CAGE_CODE == "0FW39" 

   DESIGN_ACTIVITY="STEWART & STEVENSON TACTICAL VEHICLE SYSTEMS, LP" 

   DESIGN_ACTIVITY_LOCATION = "5000 I-10 WEST, SEALY, TEXAS  77474" 

ENDIF 

if auto_part_number 

/*

/*  CHECKS FILE NAME LENGTH, LOCATION OF UNDERSCORE, LOCATION OF HYPHEN 

/*

file_name= REL_MODEL_NAME()

under_loc = search(file_name,"_") 

dash_loc = search(file_name,"-") 

file_len = string_length(file_name) 

/*
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/*  DETERMINES IF THERE IS A CAGECODE AND/OR A DASH NUMBER AS PART OF THE FILE 

/*  EXTRACTS PART_NUMBER AND EXT_PART_NUMBER FROM FILE_NAME 

/*

IF under_loc !=6

  IF dash_loc !=9 

    drawing_number = file_name 

  dash_no = "" 

  part_number = drawing_number 

  ELSE  

    drawing_number = extract(file_name,1,dash_loc-1) 

  dash_no = extract(file_name,dash_loc+1,file_len-dash_loc) 

  part_number = drawing_number + "-" + dash_no 

  ENDIF 

ELSE

  cage_code = extract(file_name,1,under_loc-1) 

  IF dash_loc != 15 

    drawing_number = extract(file_name,under_loc+1,file_len-under_loc) 

  dash_no = "" 

  part_number = drawing_number 

  ELSE 

    drawing_number = extract(file_name,under_loc+1,dash_loc-under_loc-1) 

  dash_no = extract(file_name,dash_loc+1,file_len-dash_loc) 

  part_number = drawing_number + "-" + dash_no 

  ENDIF 

ENDIF

endif 

/* 

UNIT_WEIGHT=PRO_MP_MASS 

/* 

/*  END OF FMTV START PART RELATIONS 

/* 

TABLE 13: START PART RELATIONS 

C.19  94BCHECK mapkey 
See FMTV Creo Parametric Configuration Settings document  
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C.20  95BComponent Interface functionality 
Component interface functionality was added in Creo Parametric Wildfire.  They contain a set 

of stored constraints and references that can be used repeatedly to place components.  Once an 

interface is defined and saved in a component, it can be used anytime the component is placed in the 

assembly.  Placement of components using interfaces allows them to be constrained more efficiently.   

Currently Component Interfaces are not defined on any of the parts.  If a user needs to assemble the 

same component many times they can create a Component Interface on the “In-Session” model.  By 

adding the Component Interfaces “In-Session” and using it at that time, as long as they don’t save the 

component, it will not affect the model.  These Component Interfaces can be created in both Part and 

Assembly mode. 

C.21  96BAUTO_PART_NUMBER functionality 
The AUTO_PART_NUMBER parameter was added recently to the start parts.  If the value is 

set to YES then the model automatically takes the name of the part and assigns it to the 

PART_NUMBER parameter.  If it is set to NO then it leaves it empty and the user is required to enter 

the value for the PART_NUMBER parameter. 

C.22  97BItem ID  
The Item ID is a special feature used for including the ID of the model on the model with a 

curve.  This special sketched curve feature needs to be handled differently from other curves on the 

model.  The feature shall be renamed to “ITEM_ID”, and it shall be added  to the “ITEM_ID” layer so 

that the user can easily isolate this curve feature from others in the drawing.  Typically, the Item ID is 

isolated in order to be displayed on the drawing while hiding the other datum curves. The ITEM Id 

shall be the ACTUAL ITEM ID that would be marked on the part.  A sketch feature can be used to get 

the text on the drawing. 

C.23  98BMass Properties – Manual Input 
In certain cases it is helpful to be able to enter the mass of a model manually.  Typically Creo 

Parametric will calculate the mass of the model automatically based on the assigned density and the 
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calculated volume.  Often times when dealing with purchased parts or where the material properties 

aren’t exactly known, it is helpful to be able to add the final mass manually.  In order to complete the 

task select Edit > Setup > Mass Props then choose Geometry and Parameters as the Source.  Then 

choose Edit from the Actions area and enter in value for Mass.  This value becomes known as the 

PRO_ALT_MP_MASS parameter. 

FIGURE 59:  SETUP MASS PROPERTIES 

FIGURE 60:  MASS PROPERTIES PARAMETER

C.24  99BMilitary parts and Vendor parts  
Typically, military parts are recognized by either the name of the file or by having a 

CAGE_CODE parameter filled out.  Below is a list of typical military part numbers (either 7 or 8 

digits in length) they can either have the cage code preceding the name or only as a value for the 

parameter. 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 109 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

 12xxxxxx

 116xxxxx

 87txxxx (top drawing)

 57kxxxx (kit list)

If it doesn’t meet the above criteria it could be a vendor supplied model; however, there are

exceptions so this will need to be verified. 

C.25  100BVendor supplied 3D models 
The way to handle vendor supplied 3D models has changed over time.  It is recommended to 

maintain the vendor’s naming convention so when newer models are supplied they can simply be 

updated in Commonspace. 

A common issue when dealing with vendor supplied CAD models is data transfer. 

Transferring 3D solid geometry through CAD neutral translation can cause problems when importing 

them into Creo Parametric.  Factors that affect the quality of imported data are: 

• Original CAD system

• Quality of modeling

• Model accuracy

• Model complexity

• Irregularity of Geometry

• Type of exchange file (IGES, STEP, Neutral, etc...)

3D geometry imported into Creo Parametric for the MTV database shall be converted to solid 

geometry.  The conversion to solid models helps ensure that proper model display and mass 

calculations can be made.  If the task of converting the imported geometry from surfaces to solids is 

beyond the ability of the modeler then a modeler with the appropriate ability should be tasked with 

converting the model. 

The neutral file shall be stored in the FMTV Product under the Models and 

Drawings/OEM_Models folder in Windchill PDMLink 
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C.26 102BNext Assembly Parameter 
There have been issues with the next assembly parameters with some parts that are in 

Commonspace.  The NEXT_ASSY parameter shall represent the assembly where the part is used.  The 

problem is mainly found with parts (ex: -001, -501, and -801) where the next assembly parameter has 

been filled out incorrectly.   

FIGURE 61:  ASSEMBLY STRUCTURE - NEXT_ASSY 

The left-plate, right-plate, and center-plate are the parts that make up the weldment.  In some 

occasions it has been noted that the NEXT_ASSY parameter for the plates has not been 12345678, it 

has been 12222221 (Frame Assy).  The frame assembly is the up assembly in which the weldment is 

assembled.  The plates shall have 12345678 as the next assembly.  The weldment shall have 12222221 

(Frame Assy) in its next assembly parameter. 

If a part or assembly has multiple up assemblies, then the up assemblies are listed in the parameter 

numerically. 

FIGURE 62:  NEXT ASSEMBLY LIST 

In situations where there are more than eight up assemblies, do not create additional 

NEXT_ASSY parameters.  For the drawing, a hex note can be placed in the NEXT_ASSY parameter 
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box located in the title block to relate back to the drawing notes.  The drawing note will list all of the 

next assemblies used. 

The next assembly parameter is based on the assembly that a part or assembly is configured 

into.  A Where-Used Report can be run in Windchill PDMLink to show what assemblies a part or 

assembly may be a component of.   

C.27  103BHandling a Cancelled ECP 
Occasionally after initiating an ECP that involves changing various parts, drawings, and 

assemblies it gets cancelled.  When it gets cancelled a concern is what to do with all the changes that 

were completed on the parts, drawings, or assemblies.  Ideally, all the changes on these objects shall be 

deleted or rather the PIV (Product-Item-Version) of these objects shall be deleted from Commonspace. 

Typically a lot of work goes into making these changes, which more than likely will be requested again 

in the future, and it is not cost effective to simply delete them.  Some guidelines have been set to 

dictate how to deal with these objects.  

 If the objects are the INITIAL RELEASE or CONVERTED TO PROE SOLID MODEL then

the Release Level shall be set back to Concept and the models shall be left intact.

 If the previous Revision has been promoted through to RELEASED and the changes made to

the objects were minor (i.e. note change, parameter change, etc…) then the objects shall be

deleted from Commonspace.

 If the previous Revision has been promoted through to RELEASED and the changes made to

the objects were major (i.e. major geometry changes, major drawing changes, or anything time

consuming to complete) then the objects shall be set back to Concept or deleted,.

C.28  104BKeep All Down Parts and Drawing at Same Revision when 
Promoting 
There have been many issues related to not keeping the same base number components at the 

same revision level.  The base number refers to the 8 digit number after the cage code and underscore 

in the name of the object.  The rule is that all components with the same base number must be revised 
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when the drawing is revised.  If drawing 19207_12341234.drw is being promoted to a new revision 

then all models beginning with 19207_12341234 shall be promoted along with the drawing unless 

noted on the NOR.  An exception is when in the newer revision one or more of the components are no 

longer required and those can remain at the previous revision.  All of these components shall be related 

to the drawing even if there are no views describing the individual components.  

C.29 104BWeldments 
All weldment component parts shall follow the -100 naming convention (as defined in Section 

3.8) for the inseparable assembly.  In addition, the PARTS LIST table for the weldment shall specify 

“NON-REPAIRABLE PARTS LIST” (See Figure 63) 

FIGURE 63: SAMPLE WELDMENT PARTS LIST
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D Procedures 

D.1 105BCreating a new file 
The following procedure shall be used whenever creating a new model.  This will ensure 

conformance to the latest standards and will allow the models to be tracked by Windchill PDMLink. 

This is very import in order to avoid any duplication of work. 

1. All NEW parts shall be created with the approved FMTV start parts.
2. All required parameters shall be filled out before checking files into Commonspace

 ECP_ERR_Number is important to know what ECP created the new file

D.2 107BFamily Table Drawing Creation Procedure 

D.2.1 Creating the Family Table in the Part: 

Create a family table with all of the information required to model the part.  Each instance will 

need to be given a distinctive name based on the original part number with a 19207_ prefix.   The 

part_number parameter shall be added to the family table to correctly show the part number in the 

drawing table. Additional parameters may be required to correctly represent the model at different part 

levels.  Include any technical data using string parameters, i.e.: din_number or thread_size. 

Because of issues in the past in using Family Table functionality with Creo Parametric 

assemblies it is important to only use them when it makes sense.  In order to decide when to use a 

family table to aid in building / maintaining many models follow these general guidelines or ask a local 

CAD admin or experienced user. 

 Do NOT use Nested Family Tables ever.  They will cause problems with the database 

management system. 

D.2.2 Auto Fill Instructions: 

The family table can be filled out quickly by exporting the data to Microsoft Excel using the 

following icon   .   Use the Fill > Series command to automatically complete column.  Make sure 

the column to be filled is empty and then highlight the area to be filled.  From the top pull down menu 
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select:  Edit > Fill > Series > Set Type to AutoFill and select OK.  Once this is complete, the family 

table should look like the following figure: 

FIGURE 64:  FAMILY TABLE 

D.2.3 Showing the Family Table in the Drawing: 

1. Start by creating a table with a header row and one empty row for the first field.  Only create

columns for the data that needs to be shown in the table.  Some Family Table columns are used 

only to model the part and may not need to be shown in the drawing table. 

2. Create simple repeat regions in all of the cells:

Table > Repeat Region > Add > Simple in each column, below the title, pick each of the 

empty cells twice to create a repeat region. 

3. In each column enter: &fam.inst.param.value.  :

Enter Text > Report Sym select the cell to enter text fam… inst… param… value 
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4. Add a filter to each of the repeat regions to only show the values intended for that column.

For part number, create the filter: &fam.inst.param.name==part_number. 

Table > Repeat Region > Filters > Add &fam.inst.param.name==Parameter Name - Done 

- Done/Return. 

D.3 109B2D Lightweight Backdrop Creation 
This process is for creating 2D lightweight backdrops for use in Installation and Assembly 

drawings as phantom reference geometry.   

Advantages  

 Dramatically reduce the file retrieval and regeneration time

 Geometry is clean (other methods require a substantial amount of clean-up)

 No “tag-along” parts (additional parts not used in the installation shall not be part of the
assembly)

 Skeletons can be embedded into the backdrops

 Clean BOM

 Can create a library of standard views

 Useful during the design process as well.

Step 1 - Identification 
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The following items should be considered when determining what the backdrop geometry will 

be composed of: 

 Determine the geometry and views necessary for the drawing.

 Build a temporary assembly model or use an existing assembly (using only the components that
will be seen).

 Avoid using any shrink-wraps in the model structure.

 Establish a known coordinate system location:

o For small installations with isolated components (components located in the same
general area), use the interface for the primary component (this method allows for the
lightweight backdrop to serve as a skeleton as well

o For large drawings with components spread across the chassis, use the default
coordinate system (A separate skeleton file for the multiple primary components will be
required and the associated skeleton(s) will require the same coordinate system).

Step 2 - Establish offset coordinate systems 

Coordinate System 

Reference Geometry 

FIGURE 65:  ESTABLISH OFFSET CSYS 
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Step 3 – Make DXF files 

 Create a new temporary drawing, empty, with a variable sheet size at 1 x 1.

 The format is not required; make the border size small for ease of deletion later.

 The drawing has a base coordinate at the bottom left corner.

o The location of the coordinate on the drawing will not work for lightweight backdrops

o The coordinate curves created in the prior step will be used to create the assembly

coordinates in a later step.

1mm x 1mm curves on 
outboard surface created on 
top of Coordinate in the shape 
of an “L” to help define 
directions in a coordinate 
system. 

1mm x 1mm curves on 
datum plane in front of 
cross-member 

FIGURE 66:  CREATE 2 - 1MM X 1MM CURVES 

FIGURE 67:  ANOTHER 1MM X 1MM CURVE SET 
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FIGURE 68:  CREATE DXF FROM NEW DRAWING
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Step 3a – Make the Views 

FIGURE 69:  CREATE REQUIRED VIEWS FOR INSTALLATION DRAWINGS
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Step 3b – Inspection of Lines 

 Notice the hidden lines for the steering gear casing.

 This was an imported model and will not clean up well, so either eliminate from the

assembly or replace with a true model.

FIGURE 70:  INSPECT LINES
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Step 3c – Make other Views 

 Do not make projected views or auxiliary views; make only one view at a time.

 After each view is created, save as a DXF file, using the -8xx series of names.

FIGURE 71:  MAKE OTHER VIEWS
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Step 4a – Make the Backdrop 

 Start a new part file with an appropriate name utilizing the -800 series.

 Import the DXF file:  Insert > Shared Data > From File

 Follow all the defaults:

FIGURE 72:  CREATE BACKDROP PARTS

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 123 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

FIGURE 73:  CREATE COORDINATE SYSTEM 

Step 4b – Coordinate System 

 Create a coordinate system that corresponds to the assembly

 Use the two 2D curves to establish the coordinate

 Rename the coordinate to a common identifier.
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- Another menu will appear 

- Click on the arrow and select the 4 lines of 
the format and delete them (the arrow will 
need to be selected after each line is deleted). 

- Clean off any other lines, curves, or text not 
wanted in the drawing. 

Step 5a – Cleanup 

- Select the geometry and right click 

- Then select Edit Definition 

FIGURE 74:  CLEANUP - EDIT DEFINITION 

FIGURE 75:  DELETE 4 FORMAT LINES
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Step 5b – Line Font 

 While still in the edit mode, click Edit > Feature Operations > Modify Line Style and

then change the font to phantomfont and the color to light grey.

 The 2D lightweight backdrop is now complete.

FIGURE 76:  CHANGE LINE FONT 
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FIGURE 77:  COMPLETED LIGHTWEIGHT 2D BACKDROP 

Step 6 – Lightweight Assembly 

 Assemble all of the views together to form a 2D model.

 Assemble to the common coordinates

 Save the file with the -800 series naming convention

 Skeletons can be added to this same model
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FIGURE 78:  COMPLETED LIGHTWEIGHT ASSEMBLY

Step 7 – Installation Model 

 Add the lightweight backdrop/skeleton models first

 Assemble the components in the assembly

 This is a clean assembly with no tag-along parts, other than a few models with reference

data
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FIGURE 79  COMPLETED INSTALLATION ASSEMBLY

Step 8a – The Final Drawing 

 Start the drawing and place views as normal
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FIGURE 80:  BEGIN INSTALLATION DRAWING

Step 8b – Drawing Cleanup 

 Set the drawing visibility to No Hidden

 Notice the phantom geometry is hidden out
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 Notice the lines of the other 2D views

FIGURE 81:  INSTALLATION DRAWING CLEANUP
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Step 9 – Complete Drawing as Normal 

Click View > Drawing Display > Component Display 

A new menu appears to the right, 
select Blank, pick the view, and 
then select the lines (representing 
the other backdrop parts) and 
complete 

FIGURE 82:  INSTALLATION DRAWING CLEANUP - COMPONENT DISPLAY 

FIGURE 83:  INSTALLATION DRAWING CLEANUP -
BLANK COMPONENTS
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 This works for sections and auxiliary views also

 Write a relation to remove the Lightweight Backdrop / Skeleton assembly from the BOM

 Notice now the SOLID geometry pops out in front of the PHANTOM geometry.

FIGURE 84:  COMPLETED INSTALLATION DRAWING

Backdrop Assembly Structure – Reference Information 

The first 15 steps in this section describe the methodology for creating the lightweight 

backdrop parts, assembly, and drawing.  The method for assembling installation parts in upper 

assemblies will be to create two assemblies rather than just one. 

 The first will be the base assembly without any backdrop components assembled.  (Example:

19207_12345678.asm)  This Assembly will be used in upper assemblies so backdrops will not

be visible in these assemblies.
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 The second assembly will be used in the installation drawing and will have all of the backdrop

components assembled to it (Example: 19207_12345678-800.asm).  This Assembly will only

be used in the installation drawing.  This will have all the -8xx backdrop parts assembled,

along with the base assembly.  The Model Tree would look something like the image below.

FIGURE 85:  BACKDROP ASSEMBLY TREE 

 Alternative Technique for Installation Drawings: In lieu of creating a -800 assembly, the

user can also just create the base installation and use simplified reps to control the -800 series

parts.  The -800 2D/3D backdrops are still required in this method, but a standalone -800

assembly would not be needed.  The technique for this would be to update the DEFAULT_REP

in the model, so all the -800 parts are excluded from the DEFAULT_REP. This method shall

only be used when the backdrop parts are small in size (< 2mb).

Things to keep in mind while working with Backdrop models 

 If the -8xx backdrop parts are too small for the model; the easiest way to get it to the correct

size is to modify the units.  First, change from Metric to English while doing an INTERPRET

dimensions.  Then, change back from English to Metric using a CONVERT dimensions.  This

should bring the backdrop part to normal size.

 All 2D backdrop parts shall be LIGHT GREY in line color and PHANTOM in line style.

Using Parts Table in Installation Drawing 

If a parametric parts table needs to be shown on the installation drawing, the recursive attribute 

option will have to be used on the table to show the correct parts.  Select the following commands: 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 134 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

Table > Repeat Region > Flat/Rec Item and then picking the assembly that needs to be shown (the 

base assembly).  The -800.asm and the -80x (backdrop parts) will still need to be removed from the 

parts table by either manually filtering them out or using a relation to filter them out. 

D.4 110B3D Lightweight Backdrop Creation 
This process is for creating 3D lightweight backdrops for use in Installation and Assembly 

drawings as phantom reference geometry.   

Advantages  

 Dramatically reduce the file retrieval and regeneration time

 Geometry is clean (other methods require a substantial amount of clean-up)

 No tag-along parts (additional parts not used in the installation shall not be part of the
assembly)

 Skeletons can be embedded into the backdrops

 Clean BOM

 Useful during the design process as well.

Step 1 – Identification 

The first step in this process is to determine the necessary geometry required to create the views 

on the installation drawing.  This will also require the user to have the necessary assemblies in their 

Workspace for reference. 

Step 2 – Create independent shrinkwrap model 

The first step will be to create a new Creo Parametric part.  This part will be given a -801 or 

higher number (i.e. 19207_basenumber-801.prt). 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 135 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

FIGURE 86:  CREATE 3D BACKDROP PART 

Step 3 – Create Shared Data Feature 

Select Insert > Shared Data > Shrinkwrap from the Creo Parametric main menu as 
shown below. 

FIGURE 87:  CREATE SHRINKWRAP FEATURE
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Step 4 – Select Reference Model 

From the Creo Parametric Dashboard open a model which geometry will be copied 

FIGURE 88:  SELECT SHRINKWRAP REFERENCE MODEL 

Select the model (part, assembly, or sub-assembly) to create the shrinkwrap from then select 
open. 

FIGURE 89:  CONFIRM REFERENCE MODEL SELECTION

Step 5 - Locate the model 

Define the placement by using the ACSO or CSO of the selected model and the CSO of the 

new part (-801, etc).  Select the OK button. 

Step 6 – Choose proper Pro/ASSEMBLY options 
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Select the Options tab from the Creo Parametric Dashboard 

FIGURE 90:  CHOOSE APPROPRIATE OPTIONS 

Step 7 – Choose Quality Level 

Set the quality level (Note: shrinkwraps may require this level to be adjusted until the model’s 

appearance is acceptable.  A level of one creates a smaller sized file and the higher the quality level 

setting the larger the model size). Most shrinkwraps will fall between a quality level range of 3 and 7. 

FIGURE 91:  VERIFY REQUIRED GEOMETRY IS PRESENT

Step 8 – Toggle shrinkwrap to Independent 
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Make the Shrinkwrap Independent by performing an edit definition on the external shrinkwrap 

feature and removing the check from the dependent option. 

FIGURE 92:  TOGGLE OFF "DEPENDANT" OPTION

The result will be a “stand alone” 3D model that is ready to insert into the installation and referenced 

by the installation components. 

Step 9 – Change the color and appearance of backdrop model(s) 

1. Assign colors and appearances to objects

FIGURE 93:  ACCESS APPEARANCE EDITOR
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2. Select the color grey

FIGURE 94:  SELECT GRAY COLOR 

3. Assign the color to the backdrop models > OK button > Apply button

FIGURE 95:  SELECT GEOMETRY TO APPLY COLOR

4. Set the following properties: Matte=0.00, Transparency = 80.00 and select the Close button
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FIGURE 96:  SET TRANSPARENCY 

The model should now look like the following image: 

FIGURE 97:  RESULTING 3D BACKDROP 
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The “backdrop” models are to be transparent instead of the 2D geometry representations.  This 

is a 3D backdrop not a 2D backdrop method.  The structure in the model tree remains the same as with 

the 2D backdrop method, as shown below. 

The note named Note0_DESIGN_INTENT should be used to document the name of the 

assembly used to create the shrinkwrap model.  In the future when changes occur this information will 

assist in updating the shrinkwrap model.  The user can check-out the reference assembly, toggle the 

shrinkwrap as DEPENDANT, update the shrinkwrap, and toggle back to INDEPENDENT. 

FIGURE 98:  FINAL MODEL TREE 

The assembly of solid components must be separate from the models used to make the 

backdrop.  In this case 19207_BASENUMBER.ASM shall be used in the next level assembly without 

bringing the back drop models along.  Also, the backdrop models must me completely independent 

from the models they are created from. 

3D Shrinkwrap 
component 

Installation 
Assembly 
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Step 10 – Drawing Settings for 3D backdrop parts 

The line type for 3D backdrops shall be PHANTOM.  The color of the lines on the 2D drawing 

will relate to the system settings for shrinkwraps.  

Note:  These steps were defined with Pro/ENGINEER Wildfire 2.0 and there 
may be slight menu differences in subsequent versions of Pro/ENGINEER. 
The concept should remain and slight adjustments should be manageable by 
users familiar with Pro/ENGINEER. 

129B3D-Backdrop Creation Checklist / Reference Guide 

1) Checkout the required components for the 3D Backdrop into a clean workspace.
2) Create a temporary assembly to assemble the required backdrop components. An existing assembly could

be used but to avoid accidental check-in of the assembly, it is recommended to create a temporary
assembly. The assembly should be built to the VCS (Vehicle Coordinate System) for Chassis installations
and CBCS (Cab Body Coordinate System) for Cab installations.

3) After the model is complete, export as a solid IGES file using either the VCS or CBCS as the assembly
reference point. Be sure to make the file SOLID and FLAT in the selection menu.

4) Open a new file for importing the IGES file using the desired name for the 3D Backdrop. Create a VCS
coordinate system as defined in the VCS portion of the Standard.

5) Import the solid IGES model using the default coordinate system – which is the VCS embedded in the IGES
file and the VCS created in the new part.

6) Save the file before continuing
7) Run the FXLA mapkey to fix the layers and remove the IGES imported layers.
8) Assign the material property to NONE_V1 and set the Mass Properties density to 0.0001. Write the relation

“unit_weight=pro_mp_mass” under the CSO. These settings will make sure the 3D backdrop does not
generate a mass that will drive the weight parameter on the drawing.

9) Edit the component parameters list.
10) Apply the 3D backdrop display settings IAW the CAD Modeling Standard
11) Run the Model Check and correct any errors
12) Start a dummy drawing and place the 3D backdrop into the drawing in several different views (3D, front,

side..) and verify that the viewing requirements are met.
13) Do not check in the dummy assembly or the dummy drawing.
14) Save the 3D Backdrop file and check into Windchill PDMLink.

Suggestions for a clean 3D backdrop model: 

 Do not include hardware (bolts, nuts, washers  ...) in the model  because these will make the export
model very large.

 Components not seen in any of the views on the drawing should not be shown. The idea is to make a
simple backdrop for orientation of the components installed on the vehicle. The more “stuff” in the
backdrop the larger the file will be.
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 Remember that the lines will be in phantom so the lines will be broken up. Very small parts will not be
entirely discernible so eliminate them from the backdrop unless absolutely required.

 Pay attention to the SCALE that the drawing will be presented - that will help determine what needs to
be in the backdrop model.

Possible issues:   

 If there are purple line elements in the drawing then there was an unresolved surface in the IGES file.
One way to fix this is to make a STEP file of the component before assembling it into the dummy file.
Make the IGES file again and verify that the purple entities are white.

 If the file is too large or takes too long to load, reduce the number of components and remove hardware.
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D.5 111BChecklists 
The following four tables list items and directions in order for checkers to perform their tasks. 

The four checklists include CM Checklist, Standard Model Checklist, 2D PDF Drawing Checklist, and 

Vendor / Legacy / Standard Model Checklist.  These four checklists were originally separate 

documents but were recently combined and added to this document for reference purposes. 

CM CHECKLIST 
Item TAC CTR Comments 

Note contents of Change Notice. X 
Open Creo Parametric drawing. X 
Print PDF released drawing in PDMLink and 
current rev of the Creo Parametric drawing. 

X 

Paper-to-paper comparison of PDMLink 
drawing previous rev to current Creo Parametric 
rev.  Document any differences on NOR. 

X 
Rejection item: Undocumented differences between 
approved CMSTAT drawing and new Creo 
Parametric drawing. 

Drawing Check 
Open Creo Parametric drawing & perform 
Model Check. 

X Rejection item: Model Check failed. 

Check rev. block for correct history, rev. level & 
ERR numbers. 

Rejection item: Rev. block has incorrect information 
/ Rev. block history is incomplete / Rev. level is 
incorrect / ERR number is incorrect. 

Check title block. X 
Rejection item: Title block has incorrect information 
/ Text is outside of format boundary. 

Check rev. levels on all documents X 

Check that drawing displays properly. X 

No layering standard for drawings.  Make model 
dependent on model layers instead of drawing 
layers.  Do not reject due to problem with archived 
part/assy since nothing can be done.  

General feature check. X Check that holes are features, not sketched lines, etc. 

2nd Check 
Check that rejected items are fixed. X 
If 5 items were rejected previously, recheck 
completely. 

X 

Double check that rev. block is correct. X 
Rev. history ERR numbers may have updated 
incorrectly. 

TABLE 14: CM CHECKLIST 

STANDARD MODEL CHECKLIST 
Item TAC CTR Comments 

Note contents of Change Notice / Promote. X 

Check Change Notice / Promote to determine if 
NOR is needed.  If there is no NOR, search 
PDMLink for previous rev.  (NOR is required if 
previous rev.) 

X 
NOR is not required for initial release or the first 
time an object is placed in PDMLink 

Check that only one drawing is attached to RTP. X Reject if more than one drawing is attached to an 
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RTP. 

Run Where Used report on each part/assembly being 
promoted.  Check that next up assemblies at release 
level Preliminary Release or higher regenerate before 
promoting part or assembly to Preliminary Release. 

X 
Rejection item: Components do not assemble 
correctly in assembly. 

Promoting Assemblies:  All subordinate items must 
be at the same or higher release level than the 
assembly being promoted. 

X 

Create a workspace and check out RTP contents. X 

If no drawing is present, check for PDF drawing. X 
Make sure drawing or PDF drawing is attached to 
package. 

Print the NOR. X If needed. 
Print the PDF Drawing. X If needed. 

X  If Needed 
Print out released Drawing & current rev. of Creo 
Parametric Drawing. 

X 

Check that all parts/assemblies/drawings are named 
correctly 

X X 
(Stds. Para. 3.8/4.5/5.15) Will be confirmed by 
ModelCHECK only. 

Paper-to-paper comparison of the released drawing  
previous rev. & current Creo Parametric rev. 

X Any differences must be documented on NOR. 

Check parameters in PDMLink X 
See Attachment A.  Reject if any parameters have 
incorrect/missing values. 

Drawing Check 
Open Creo Parametric Drawing: Perform Model 
Check at the beginning and end of the check. 

X 
Verify no errors or valid warnings exist. (Stds. 
Para. 2.10.1) 

Check rev. block. X 

ERR number should be correct / Rev. history and 
level should be correct / Format should be correct / 
Line format color should be correct / Text should 
be correct size and color. 

Check that correct distribution statement is located at 
the bottom of every drawing sheet 

X Dist. Statements A, B, C, D, and X can be used. 

Check that correct EAR or ITAR statement is located 
in the bottom left hand corner of each sheet. 

 X 
Only Dist. Statements B, C, D, and X require an 
EAR or ITAR statement. 

Revision block has been updated as appropriate X Stds. Para. 5.11 

Check title block. X 
Check that text does not exceed format boundary / 
Verify title block information. 

Check that entities are related to appropriate view. X X 
Exceptions, notes, BOM Table, symbols etc. 
should be related to correct views or host entities.  
(Stds. Para. 5.7) 

Verify correct line weights/colors. X X Stds. Para. 5.8 

Check that drawing displays properly. X 

No layering standard for drawings.  Make model 
dependent on model layers instead of drawing 
layers.  Do not reject due to problem with archived 
part/assy since nothing can be done.  

Switch Dimensions to check that dims, notes are 
driven from the model, thus verifying that they are 
parametric. (Exception: Preliminary) 

X 

Notes should be driven from model.  Most or all 
dimensions should be driven from model (not 
created). Stds. Para. 5.1 This will not be checked.  
However, overridden dimensions (@o) can be 
rejection items on a case by case basis. 

Parameters and notes originate from the drawing 
model. 

X Stds. Para. 4.3 & 5.13 
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GTOLs attached to base dimensions, datum planes or 
surfaces, not unattached notes. 

X Stds. Para. 5.2 

Verify correct text height. X 
Verify note contents & spelling. X 
Verify that all dimensions & geometric features are 
displayed. 

X 

General feature check. X 
Check that holes are features, not sketched lines, 
etc. 

Verify all required geometric tolerances and datum 
references exist. 

X  
Verify during visual check of drawing only - not at 
the part/assy levels.  (Stds. Para. 3.2) 

Parts contain curves or box with note reference to 
represent part number (if necessary). 

X  
Verify during visual check of drawing only. (Stds. 
Para. 3.1.1/4.1.1/4.2) 

Drawing Revision is 1 higher than currently released 
version. 

X If revising current drawing.  (Stds. Para. 2.8.2) 

All drawing deficiencies in TVPDMS have been 
resolved and the drawing conforms to the resolutions 
when applicable.  Outstanding ECPs have been 
investigated. 

X Stds. Para. 2.2 

All differences between new & old drawings have 
been documented by NOR. 

X Stds. Para. 2.8.1 

A visual check (comparison) of new & original 
drawing has been completed and all required 
information has been accurately transferred to the 
new drawing. 

X  
Current drawing conversions only.  (Stds. Para. 
3.1.2.1) 

Part Check 

Perform Model Check at the beginning and end of the check. 

Run Model Player. X Force regeneration. 
Check layers and their status. X 
Check Item ID layer. X 
Check that correct distribution statement is located in 
the model tree labeled "Distribution_Note" 

X Dist. Statements A, B, C, D, and X can be used. 

Check that correct EAR or ITAR statement is located 
in the model tree as a note. 

 X 
Only Dist. Statements B, C, D, and X require an 
EAR or ITAR statement. 

Verify all geometric tolerancing datum planes are on 
the G_DTM_PLANES layer. 

X (Stds. Para. 3.11) 

Check part specific notes. X FMTV Tools - General Note Editor is available. 

Check Model Tree for "Note 0" / Suppressed 
Features / "DWG_NOTE" 

X 

Check defined material and material note 2. X They should be the same. 

Check material callout. X X 
Dummy material callout not allowed.  All 
appropriate material files must be assigned to part.  
Primary material file is current.  (Stds. Para 3.3) 

Check units (must not be Newtons) X 
Model units and Windchill PDMLink parameter 
units must be the same. 

Check parameters for omissions or value errors. X See Attachment A. 
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Check for weak dimensions. X No weak dimensions allowed. 

Check relations. X 
Remove any old "Standard Relations" and verify 
proper comment lines. 

General feature check. X 
Check that holes are features, not sketched lines, 
etc. 

Verify that the part is representative of physical 
characteristics of real part. 

X X 

Verify part modeled matches latest released 
revision of drawing.  Outstanding ECPs have been 
investigated.  All drawing deficiencies in 
TVPDMS have been resolved and part conforms 
to resolutions when applicable.  (Stds. Para. 2.2)  

All features in the original drawing must be included 
in the model. 

X Stds. Para. 3.1.1 

Check 3D note naming and contents X IAW Standards Para. 3.5 

The part regenerates without failure or external input 
required. 

X Stds. Para. 3.1.3 

Assembly Check 

Perform Model Check at the beginning and end of the check. 

Run Model Player. X Force regeneration. 
Check layers and their status. X 
Check Item ID layer. X 
All geometric tolerancing datum planes have been 
added to the "G_DTM_PLANES" layer. 

X Stds. Para. 4.7 

Check part specific notes. X FMTV Tools - General Note Editor is available. 

Check Model Tree for "Note 0" / suppressed features 
/ packaged components / "DWG_NOTE" 

X 

Check that correct distribution statement is located in 
the model tree labeled "Distribution_Note" 

X Dist. Statements A, B, C, D, and X can be used. 

Check that correct EAR or ITAR statement is located 
in the model tree as a note. 

 X 
Only Dist. Statements B, C, D, and X require an 
EAR or ITAR statement. 

Check for Ref. parts (no cage code). X 

All assembly parts must have a cage code.  
Assembly cannot be promoted to Preliminary 
Release until all down level parts and assemblies 
that are not part of the current ECP are at release 
level Released. 

Check parameters for omissions or value errors. X See Attachment A. 

Check for weak dimensions. X No weak dimensions allowed. 

Check relations. X 
Remove any old "Standard Relations" and verify 
proper comment lines. 

Verify the /* has been removed from the 
UNIT_WEIGHT=MP_MASS("") code line. 

X  
(Stds. Para. 3.12.4)  Check by confirming 
Unit_Weight is appropriate. 

General feature check. X 
Check that holes are features, not sketched lines, 
etc. 

If 5 rejection items are found, stop checking and 
return to sender. 

X 
Rejection item: Checking is being stopped at this 
point.  5 Checklist items have been discovered 
with invalid information.  Entire package is being 
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rejected.  Please review all objects according to 
TACOM BULLETIN-CHECKLIST-100 

Check that parts of a weldment or assembly contain 
all part specific notes. 

X  

The only notes to be verified in down level parts 
will be Note#1 (standards/specs) and the material 
note for the specific part.  (EX: Assembly material 
Note#6 does not have to be in Part Note#6 -> Part 
note may be #2, etc. (Stds. Para. 3.5) 

Assembly modeled matches latest released version of 
the drawing. 

X  

Outstanding ECPs have been investigated.  All 
drawing deficiencies in TVPDMS have been 
resolved and assembly conforms to the resolutions 
when applicable.  (Stds. Para 2.2) 

All parts in the original drawing are included in the 
model and for assemblies, that all parts are 
assembled correctly.  (Ex: make sure that -001 part is 
not assembled for a -002 part) 

X  
This is confirmed during visual comparison 
between drawing and assembly model. (Stds. Para 
4.1.1) 

All assembly features are present, are truly assembly 
features, and should not be part features. 

X  
This item should not be checked, per decision at 
January 2004 IPR. (Stds. Para. 4.1.3) 

The assembly of the model follows a logical 
sequence. 

X This will not be checked.  (Stds. Para 4.1.2) 

The assembly regenerates without failure or external 
input required. 

X Stds. Para. 4.1.4 

Verify 3D note naming and contents. X IAW Standards Para. 4.3 

No packaged components unless appropriate. X Stds. Para. 4.1.5 

Voting Notifications 
Rejections Note: After voting to reject an RTP, all RTP items must be locked and transferred back to the originator. 

Voting: After voting, send an email notification to 
the originator. 

X Rejection notification or Approval Notification. 

2nd Check 

Run Model Check. 

Run Model Player. X 
Check that rejection items are fixed. X 

Double check that rev. block is correct. X 
Rev. history ERR numbers may have updated 
incorrectly. 

Windchill PDMLink 
All required parameters have been correctly entered. 
Drawing, Part, Assembly & PDMLink parameters 
are set to the correct (& same) level. 

X Stds. Para. 2.8.1 

Unit_Weight is appropriate for parts & assemblies. X Stds. Para. 3.12.4 

X Stds. Para. 2.10 – Not required 
NOR document is filled out and related to the Creo 
Parametric drawing as attachment 

X Stds. Para. 2.10 

All parts defined by a drawing are related to the 
drawing even if they are not used in a view on the 
drawing. (Ex: -500, -800 part) 

X Stds. Para. 5.12 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 149 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

Drawing is promoted in accordance with the current 
release procedure document. 

X Stds. Para. 2.10 

TABLE 15: STANDARD MODEL CHECKLIST 

2D PDF DRAWING CHECKLIST 
Item TAC CTR Comments 

Note contents of RTP. X 
X Reject if QA document is attached to RTP. 

X

Check that only one drawing is attached to RTP. X 
Reject if more than one drawing is attached to an 
RTP. 

Create a workspace and check out RTP contents. X 
Check that QA Comments sheet is attached to 
drawing. 

Print the NOR. X If required. 
Print the PDF Drawing. X 
Update QA Comment form to reflect contents of RTP. X  If required 
Print out released Drawing previous rev. X 
Check that PDF drawing is named correctly. X X (Stds. Para 5.15)

PDF/2D Drawing Check 
Paper-to-paper comparison of the CMSTAT previous 
rev. & current PDF rev. 

X Any differences must be documented on NOR. 

Verify that all changes listed on NOR have been 
incorporated on PDF drawing. 

X 

Check parameters in PDMLink X 
See Attachment A.  Reject if any parameters have 
incorrect/missing values. 

Voting Notifications 
Rejections Note: After voting to reject an RTP, all 
RTP items must be locked and transferred back to the 
originator. 

X 

Voting: After voting, send an email notification to the 
originator. 

X Rejection notification or Approval Notification. 

2nd Check 
Check that rejection items are fixed. X 

Do not need to do a full check of everything. X 
Unless 5 items were previously rejected, then 
recheck completely. 

TABLE 16: PDF DRAWING CHECKLIST 
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VENDOR/LEGACY/STANDARD PART MODEL CHECKLIST 

Item TAC CTR Comments 
Note contents of RTP. X 
Check RTP to determine if NOR is included.  If there is 
no NOR, search Pro/INTRALINK for previous rev. 
(NOR is required if previous rev.) 

X 

Check that only one drawing is attached to RTP. X 
Reject if more than one drawing is attached to 
an RTP. 

Run Where Used report on each part/assembly being 
promoted.  Check that next up assemblies at release level 
QA1 or higher regenerate before promoting part or 
assembly to QA1. 

X X 
Rejection item: Components do not assemble 
correctly in assembly. 

Promoting Assemblies:  All subordinate items must be at 
the same or higher release level than the assembly being 
promoted. 

X 

Create a workspace and check out RTP contents. X 
Check that QA Comments sheet is attached to 
drawing. 

If no drawing is present, check for PDF drawing. X 
Make sure drawing or PDF drawing is 
attached to package. 

Print the NOR. X If needed. 
Print the PDF Drawing. X If needed. 
Update QA comments form to select contents of RTP. X 
Print out CM-Stat Drawing & current rev. of Creo 
Parametric Drawing. 

X 

Check that all parts/assemblies/drawings are named 
correctly 

X X 
(Stds. Para. 3.8) Will be confirmed by 
ModelCHECK only. 

Paper-to-paper comparison of the CMSTAT previous 
rev. & current Creo Parametric rev. 

X 
Any differences must be documented on 
NOR. 

Check parameters in PDMlink. X 
See Attachment A.  Reject if any parameters 
have incorrect/missing values. 

Part Check 
Run Model Player. X Force Regeneration. 
Check parameters for omissions or value errors. X See Attachment A. 

Verify that the part is representative of physical 
characteristics of real part. 

X X 

Verify part modeled matches latest released 
revision of drawing.  Outstanding ECPs have 
been investigated.  All drawing deficiencies in 
TVPDMS have been resolved and part 
conforms to resolutions when applicable.  
(Stds. Para. 2.2) 

Part regenerates without failure or external input 
required. 

X Stds. Para. 3.1.3 

Voting Notifications 
Rejections Note: After voting to reject an RTP, all RTP 
items must be locked and transferred back to the 
originator. 

X 

Voting: After voting, send an email notification to the 
originator. 

X 
Rejection notification or Approval 
Notification. 

Verify that part can be assembled into next higher 
assembly. 

X 

2nd Check 
Run Model Check. X 
Run Model Player. X 
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Check that rejection items are fixed. X 

Do not need to do a full check of everything. X 
Unless 5 items were previously rejected, then 
recheck completely. 

Double check that rev. block is correct. X 
Rev. history ERR numbers may have updated 
incorrectly. 

Windchill PDMLink 
All required parameters have been correctly entered. X 

For Vendor supplied and standard part models, a reduced 
number of parameters are required. 

X  

If values are known, enter the following 
parameters:  PART_NUMBER, 
DRAWING_NUMBER, CAGE_CODE, 
NOMENCLATURE, UNIT_WEIGHT, 
MODEL_REV, MODELER_NAME_1 
(modeler name can be the company that 
supplied the model). 

TABLE 17: VENDOR / LEGACY / STANDARD PART MODEL CHECKLIST 

D.6 112BProcedure for Promoting Objects to a new Revision 
 Check out everything with the same base number (e.g. 19207_12421234.drw where 12421234

is the base number). An exception is when in the newer revision one or more of the components

are no longer required and those can remain at the previous revision.

 Modify everything with the same control number.

 Change the following attributes:

o VERSION - revision on ECP

o RELEASE_LEVEL - In Work

o ERR_ECP_NUMBER - the current ECP number

o ERR_ECP_APPROVER - replace current name with name of approver

o ERR_ECP_DATE - replace current date with YY-MM-DD (to be changed later)

 Check the Objects into Commonspace

 Windchill Parts and Drawings shall also be revised at the same time.

 Refer to PDMLink User Guide for a Step by Step Guide on how to Promote Objects
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D.7 113BSuperseded and Obsolete Parts 
A superseded or obsolete part should not be modeled.  The main goal is to model only active 

parts on a drawing, thus superseded/obsolete are not needed.  If the drawing has both superseded and 

active parts, only model the active parts.  The following is only if the drawing has not been 

converted to Creo Parametric. 

How this is handled: 

 Remove the Superseded / Obsolete part from the drawing

 If the Superseded / Obsolete part is on the sheet before the production / active part, move the

production / active part to the earlier sheets and remove the extra sheets.

 Update Part Tables (If any) to the superseded parts to say REMOVED AT REV (X) either in

the SHEET column or in the DESCRIPTION column.

FIGURE 99:  FROM-TO EXAMPLE 

 Document all changes as normal in the NOR, including removal of sheets, updating of tables,

moving the production/active part to earlier sheets, etc.

If the drawing is completely obsolete (no active parts on the drawing), do not model that part or

drawing.  If for some reason the models are required it can be modeled, but that should be a rare case. 
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If the drawing has already been converted to Creo Parametric and a future revision will 

supersede / obsolete a part on the drawing, the model shall NOT be removed from the drawing.  This 

will allow the user to leave the models on the drawing and not have to shift around multiple views. 

D.7.1  142BSuperseded and Obsolete Parts – Revision Block 

143BThe revision block shall conform to the ASME Y14.35M standard.  In addition, if a part is 

superseded by a new drawing, place a marking above the Title Block that states SUPERSEDED 

BY 12XXXXXX (part number) in a balloon as depicted in Figure 100 

144B

FIGURE 100: SUPERSEDED CALLOUT

D.8  114BLabels and Nameplate Modeling Procedure  
All labels and nameplates (placards) are to be created and maintained in Creo Parametric. 

D.9 115BInstallation Drawings/Assemblies 
All installation drawings/assembly models shall contain a Vehicle Coordinate System (VCS) for ease 

of assembling to Chassis and Top Level models (Refer to Appendix E). 
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E Vehicle Coordinate System 

E.1 53BVehicle Coordinate System (VCS) 
Note: The VCS listed below for FMTV was established for the FMTV A1P2 variant.  The information 

remains for historical purposes only. 

The VCS is the driving base coordinate system for all FMTV trucks. The VCS is established by the 

intersection of the 3 Planes representing the length, width and height of the truck; x, y and z 

respectively. The 3 planes coincide with the axis through the E Datum hole on the frame rails for the X 

axis (length) and the Z axis (height) and the centerline of the vehicle for the Y axis (width). The E 

Datum lines up with the theoretical centerline of the front axle and establishes the F Datum at the 

opposite end of the frame rail which lines up with the rear axle/trunion centerline. The frame rail 

dimensioning scheme is based on the E Datum and all hole features are constrained back to the E 

Datum. This is the same for all frame rails (roadside and curbside) therefore this is the logical location 

for the VCS.  The right hand rule establishes that from the VCS, the X is positive rearward, Y is 

positive towards the Curbside and Z is positive vertically. This coordinate shall be included in all 

Installation assembly models and named as VCS. As a default, the intersection of the Front, Side and 

Top planes establish the X, Y and Z planes respectively. 

FIGURE 101: VCS ESTABLISHED ON ROADSIDE FRAME RAIL
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FIGURE 102: VCS IN DEFAULT VIEW

In “default” view orientation, the VCS is established at the intersection of the three default assembly 

datum planes. Notice the orientation of the X, Y and Z datum references. This is essential that they are 

oriented in this manner or the whole purpose for the VCS is of no value.  
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FIGURE 103: VCS WITH FRAMERAIL

The same default view with the frame assembly added for clarification is shown below. DRAFT
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FIGURE 104: VCS IN DEFAULT WITH FRAMERAIL

For Installations that are created with the VCS in mind, the VCS coordinate as shown is at the 

intersection of the default datum planes and the XYZ orientation established as shown earlier. If the 

Installation assembly is not built off the default datum planes, then the VCS coordinate can still be 

OFFSET by either a set of datum planes, curves, points or by another coordinate system.  

Front Cab Mount Installation shown below with the VCS and CBCS (Cab Body Coordinate System – 

explained later). 
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FIGURE 105: FRONT CAB MOUNT INSTALLATION WITH VCS

The Installation can then be assembled to the Frame assembly by mating the 2 VCS coordinate system 

points and it will snap into place as shown below. 
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FIGURE 106: FRONT CAB MOUNT ASSEMBLY CONSTRAINT

FIGURE 107: FRONT CAB MOUNT INSTALLED

E.2 54BCab Body Coordinate System (CBCS)  
The CBCS is the coordinate system for the Cab body and all related installations shall have a 

coordinate placed and named as the CBCS. The top level Dressed Cab model shall have the VCS 
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included in it as well. The CBCS varies between the different cab designs but it shall be established by 

following the same X Y Z relationship and orientation as the VCS. 

The location of the LTAS Cab CBCS and the chassis VCS is shown below: 

FIGURE 108: CBCS OFFSET FROM VCS DIMENSIONS

FIGURE 109: CBCS IN DEFAULT ORIENTATION
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E.3 55BRoadside (aka RS and Driver Side) and Curbside (aka CS and 
Passenger Side) 

The “roadside” of the vehicle is the side of the vehicle that is parallel to the road and the “curbside” is 

the side parallel to the curb. The usage of Left side and Right Side can be confusing because in 

orthographic drafting terms, the roadside view is the right side but WRT vehicular terms, it is left side 

because that is how the view is observed by the Driver while sitting in the vehicle. For clarity and 

uniformity, roadside and curbside have been designated. DRAFT
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F Special Part and Drawing Types 

F.1 Standard Parts 
Standard parts are components defined by standards organizations and are not under the control 

of the Tactical Vehicle (TV) group at TACOM.  These would include parts defined by SAE, NAS, 

ANSI, and MS to name a few.  These parts are modeled as needed and reflect the size shape and 

weight of the actual parts.  An abbreviated set of parameters is needed for these parts.  As these parts 

are not controlled by TV, a drawing is not created, and an ECP is not processed.  Parts should be 

checked by a second modeler to ensure the basic geometry and weight are correct and the necessary 

parameters are filled out.  The parts can then be promoted directly to the Released state.  Care should 

be taken in naming the parts.  MS35489-23 is not the same as MS35489-023.  These parts shall all be 

located in the / STANDARD PART LIBRARY / MODELS AND DRAWINGS folder in Windchill 

PDMLink and not in the folders where they are used (release procedure issues). 

In addition, the Specification Number shall be filled into the SPEC_NUMBER parameter.  This 

Spec Number shall match exactly what the Spec says.  In addition, the spec shall be called out on the 

drawing in either the notes section or within the Table (See Figure 110).  Users can use table 

sbpartslist_spec.tbl in Commonspace.  When multiple specs are called out on a drawing, the table 

method is preferred. 
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FIGURE 110: SPECIFICATION PARTS KIST

F.2 Common Parts 
Common parts are parts that have TACOM (TV) drawings and are used across multiple 

systems.  They must be released with an ECP.  It will be an Administrative 2 ECP (assuming no real 

content changed) to speed the process.  What makes up a Common part?  Items to look for:  Does the 

drawing contain all the information required to actually manufacture the part? If not, it may be a 

common part.  Is it an item that is stocked normally (e.g. clamps, bolts, nuts)?  Does the drawing 

reference other standard part numbers e.g. is there a DIN (or other) part number called out on the 

drawing?  If the drawing is completely detailed to the point that it could be manufactured from the 

drawing, it probably is not a common part.  Common parts should be located in the Common_Parts 

directory (again release procedure issues).   

F.3 132BDeformed parts 
Deformed parts are parts that change shape upon installation.  These parts have a couple of 

subdivisions that are treated differently.  Items that are always deformed fairly consistently upon 

installation e.g. pop rivets, lock washers etc. have an uninstalled model(s) named with a –998 (and 

lower) for pictorial use on the drawing.  The installed versions are created in their deformed state and 
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named with the standard dash numbering system.  Items with a specific grip range should be modeled 

at their maximum grip range.  The reason for this approach is to limit the vast number of parts that 

would be created if a model had to be created for each possible variation in installation.  Items that are 

deformed differently upon each installation e.g. hose clamp, springs, etc. will use a –900 series part of 

the up assembly.  The parameters of the –900 part should reflect the parameters of the up assembly 

except for Nomenclature, drawing number and most importantly part number.  This method was 

implemented when it was discovered that the previous practice of ‘partnumber_in_partnumber’ did not 

work if there were dash numbers in both part numbers.  This workaround may be able to be eliminated 

in future versions of Creo Parametric.  Flexible components are still the preferred method in lieu of 

creating a -900 series part. 

For example: 

MS21266-2N (Grommet, Plastic, and Edging) is an item that is used in many assemblies and is 

deformed differently each time.  Let’s say it is used in an assembly 12345678.  The file name for the 

grommet used in this assembly would be 19207_12345678-900.prt 

NOMENCLATURE parameter value would be:  GROMMET, PLASTIC, EDGING 

PART NUMBER parameter would be:  MS21266-2N 

DRAWING NUMBER parameter would be:  MS21266 

If it is used a second time in the same assembly and has a different shape, it would be the same except 

the file name would be 19207_12345678-901 

F.4 133BVendor Item Control Drawings 
Specification Control drawings now changed to Vendor Item Control Drawing.  Parts in this 

category generally do not have complete definition of the part required to manufacture the part. 

Dimensions that do not appear on the drawing are not checked.  If missing dimensions, actual parts 

should be obtained and measured to create a model that is representative of the actual part and allow a 

drawing to be created that is similar to the original.  The part should be weighed and an appropriate 
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weight defined in the part.  Sectional views that are for general information do not have to be recreated 

during the conversion efforts.  If there is required information in the section, it still has to be created.  

F.5 134BSource Control Drawings 
Similar to Vendor Item Control Drawings as far as modeling is concerned.  They will often 

have even fewer dimensions.  If a model is available from a vendor but does not have all of the 

parameters etc. then an assembly should be made using the TV start assembly.  All appropriate 

parameters etc can then be filled out in the assembly.  For Source Control electrical drawings, see 

section 7.1.20 for Schematic reference. 

F.6 135BInstallation Drawings 
In Appendix D.3 of this document, the acceptable methods for creating and working with 

lightweight backdrops for installation drawings are described.  Using full 3D solid models as 

backdrops for installation drawings is not acceptable, regardless of how simple the backdrop objects 

are.  3D shrink-wraps are acceptable, which is defined in Appendix D.4.  The 2D background geometry 

can be created from Creo Parametric models, snapshots, copy geometry, or from imported 2D 

geometry. 

F.7 136BA1R ECP parts 
Due to the timeframe of the ECP’s as well as the fact that the baseline of the truck has not yet 

been released, A1R parts and drawings are treated a little differently.  For checking purposes, three 

parameters do not have to be filled out.  Drawing Number, Tolerance Angle, and Weight Unit. 

‘Background’ or ‘Legacy’ parts are parts that are created to complete an installation, but are not the 

released version of the part; do not have to be checked.  These parts do not have the cage code 

identifier in the front of the file name.  They should have an ‘OLD_’ at the front to help eliminate the 

chance they are used in lieu of the released parts in the future. 

DRAFT

UNCLASSIFIED



 

3-Dimensional Technical Data Package Configuration Management, 
Modeling, & Drawing Interim Operating Procedure for PdM-MTV

Page 166 13 February 2014 FMTV-MODELING-STD-100T  Rev.L  

Distribution Statement A: Approved for Public Release; Distribution is Unlimited 

References 

 ASME Y14.100-2013 – Engineering Drawing Practices

 ASME Y14.5-2009 – Dimensioning and Tolerancing

 ASME Y14.35M – Revision of Engineering Drawings and Associated Documents

 MIL-STD-3046 – Configuration Management

 FMTV Creo Parametric Configuration Settings

 FMTV PDMLink User GuideDRAFT

UNCLASSIFIED


	Cover 0024
	Attachment 0024 SOW 4147, TDP2_FMTV-Modeling-STD-100T_Rev_L



